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About  this  guide  

This guide contains information about installing and using the master console. 

v   Chapter 1, “Overview,” on page 1 provides an overview of the master console. 

v   Chapter 2, “Concepts,” on page 3 discusses concepts that will help you 

understand how the master console works. 

v   Chapter 3, “Planning for the master console,” on page 7 describes how to plan 

for the installation of the master console. 

v   Chapter 4, “Installing master console software,” on page 11 provides the 

procedures required to install the master console, including how to use the 

master console installation wizard. 

v   Chapter 5, “Configuring the master console,” on page 23 explains how to 

configure the master console. 

v   Chapter 6, “Managing the master console,” on page 31 provides an overview of 

the tasks that you might perform occasionally to maintain the master console so 

that it effectively manages the SAN Volume Controller. 

v   Chapter 7, “Uninstalling master console software,” on page 35 provides a 

high-level overview of the procedures for uninstalling the master console 

software. 

v   Chapter 8, “Upgrading the master console software,” on page 39 explains how to 

upgrade the master console software. 

v   Chapter 9, “Troubleshooting the master console,” on page 45 provides 

information about resolving problems with the master console.

Who should use this guide 

This topic describes the audience for this guide. 

The IBM® System Storage™ Master Console for SAN Volume Controller: Installation and 

User’s Guide should be used by the person or persons assigned to manage SAN 

Volume Controller on a regular basis. 

An administrator should have experience in at least the following skills, or have 

access to personnel with experience in these skills: 

v   Microsoft® Windows® and Windows Advanced Server (depending on your client 

environment) 

v   Networking and network management 

v   SAN management 

v   Command-line interface scripting 

v   Critical business issues (such as backup, disaster recovery, and security)

Conventions and notices 

This topic describes the notice conventions used in this publication. 

The following notices are used in this publication and convey these specific 

meanings: 

Note:  These notices provide important tips, guidance, or advice.
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Attention:  These notices indicate possible damage to programs, devices, or data. 

An attention notice appears before the instruction or situation in which damage 

can occur.

 CAUTION: 

These notices indicate situations that can be potentially hazardous to you. A 

caution notice appears before the description of a potentially hazardous 

procedure step or situation.

 DANGER

These notices indicate situations that can be potentially lethal or extremely 

hazardous to you. A danger notice appears before a description of a 

potentially lethal or extremely hazardous procedure step or situation.

Emphasis 

Different typefaces are used in this guide to show emphasis. 

The following typefaces are used to show emphasis: 

 Boldface Text in boldface represents menu items and 

command names. 

Italics Text in italics is used to emphasize a word. 

In command syntax, it is used for variables 

for which you supply actual values, such as 

a default directory or the name of a cluster. 

Monospace Text in monospace identifies the data or 

commands that you type, samples of 

command output, examples of program code 

or messages from the system, or names of 

command flags, parameters, arguments, and 

name-value pairs.
  

Web  sites 

This topic discusses any Web sites that offer additional, up-to-date information. 

The following Web site has additional and up-to-date information about SAN 

Volume Controller: 

v   www.ibm.com/storage/support/2145/

Master console library and related publications 

A list of publications that are related to this product are provided to you for your 

reference. 

The information in this section lists and describes the following publications: 

v   The publication that is available for the IBM System Storage master console for 

SAN Volume Controller 

v   Other IBM publications that relate to the master console
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Master console library 

The following publication is available in the master console library. It is provided 

in softcopy on the CD set for the IBM System Storage Master Console and at 

http://www.ibm.com/storage/support/2145. 

Note:  The softcopy version of this publication is accessibility-enabled for the IBM 

Home Page Reader. 

v   IBM System Storage Master Console for SAN Volume Controller: Installation and 

User’s Guide, GC30-4090 

This publication provides detailed procedures to set up and cable the hardware, 

install and upgrade the master console software, configure the software 

components, and troubleshoot and resolve problems.

Other IBM publications 

The following tables list and describe other IBM publications that contain 

additional information related to the master console. 

SAN Volume Controller publications 

The following publications are related to the SAN Volume Controller. Unless 

otherwise noted, these publications are available in Adobe portable document 

format (PDF) from the following Web site: 

http://www.ibm.com/storage/support/2145 

 Title Description Order number 

IBM System Storage SAN  

Volume Controller: 

Command-Line Interface User’s 

Guide 

This guide describes the 

commands that you can use 

from the SAN Volume 

Controller command-line 

interface (CLI). 

SC26-7903 

IBM System Storage SAN  

Volume Controller: 

Configuration Guide 

This guide provides 

guidelines for configuring 

your SAN Volume Controller. 

SC26-7902 

IBM System Storage SAN  

Volume Controller: Host 

Attachment Guide 

This guide provides 

guidelines for attaching the 

SAN  Volume Controller to 

your host system. 

SC26-7905 

IBM System Storage SAN  

Volume Controller: Installation 

Guide 

This guide includes the 

instructions the service 

representative uses to install 

the SAN Volume Controller. 

GC26-7900 

IBM System Storage SAN  

Volume Controller: Planning 

Guide 

This guide introduces the 

SAN  Volume Controller and 

lists the features you can 

order. It also provides 

guidelines for planning the 

installation and configuration 

of the SAN Volume 

Controller. 

GA32-0551 
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Title Description Order number 

IBM System Storage SAN  

Volume Controller: Service 

Guide 

This guide includes the 

instructions the service 

representative uses to service 

the SAN  Volume Controller. 

GC26-7901

  

How to order IBM publications 

The publications center is a worldwide central repository for IBM product 

publications and marketing material. 

The IBM publications center 

The IBM publications center offers customized search functions to help you find 

the publications that you need. Some publications are available for you to view or 

download free of charge. You can also order publications. The publications center 

displays prices in your local currency. You can access the IBM publications center 

through the following Web site: 

http://www.ibm.com/shop/publications/order/ 

How to send your comments 

Your feedback is important to help us provide the highest quality information. If 

you have any comments about this book or any other documentation, you can 

submit them in one of the following ways: 

v   e-mail 

Submit your comments electronically to the following e-mail address: 

starpubs@us.ibm.com 

Be sure to include the name and order number of the book and, if applicable, 

the specific location of the text you are commenting on, such as a page number 

or table number. 

v   Mail 

Fill out the Readers’ Comments form (RCF) at the back of this book. If the RCF 

has been removed, you can address your comments to:

International Business Machines Corporation 

RCF Processing Department 

Department 61C 

9032 South Rita Road 

Tucson, Arizona 85775-4401 

U.S.A. 
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Summary  of  changes  

This document contains terminology, maintenance, and editorial changes. 

Changes made in release 4.1 

Technical changes or additions to the text and illustrations are indicated by a 

vertical line to the left of the change. 

The following list describes the changes made to the IBM System Storage Master 

Console for SAN Volume Controller: Installation and User’s Guide in release 4.1. 

New information 

New information in release 4.1 of this guide includes: 

v   Remote service is now managed by the IBM Virtually On-site (VOS) tool, 

which is not a part of the master console but, instead, a remote 

desktop-sharing Web-based tool that is available on the IBM Web site. 

IBM Connection Manager is no longer needed for remote service. 

v   New instructions are included for upgrading the master console to 

version 4.1. 

v   The master console can support up to four SAN Volume Controller 

clusters. 

v   Configuration planning information has been added. 

v   Instructions for changing the master console host name and updating 

the name in other master console applications has been added to the 

Chapter 6, “Managing the master console,” on page 31 chapter. 

v   A glossary has been added.

Changed information 

Changed information in release 4.1 of this guide includes: 

v   The introductory information about the master console has been 

enhanced. 

v   The prerequisite information for the software master console has been 

updated. 

v   The edition for the Microsoft Windows Server 2003 preinstalled on the 

hardware version of the master console has been clarified. 

v   Only one Ethernet connection is now required because the VPN 

connection to the external internet is no longer required for remote 

service. 

v   The configuration steps note whether they apply to both the hardware 

and software master console, or to only the hardware master console. 

v   The process for reviewing a softcopy version of this documentation and 

browsing IBM Support Web sites during the installation has been 

updated. 

v   The instructions for setting up the call home feature now include 

information for the 8F4 model. 

v   The command for replacing a client SSH private key known to the SAN 

Volume Controller software was corrected. 

v   Some of the instructions for installing the IBM Director have been 

updated. 
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v   The method that you use to open the Event Log for IBM Director has 

changed. To open it, you click Tasks → Event Log → Event Log: Open.

Deleted information 

Information that was deleted from release 4.1 of this guide includes: 

v   Conceptual and task-oriented information about the following 

components was removed because the master console no longer needs 

these components: 

–   DB2® 

–   DS4000 Storage Manager Client (FAStT Storage Manager Client) 

–   IBM Tivoli® Storage Area Network Manager (Tivoli SAN Manager) 

–   IBM Connection Manager
v   Information about establishing a VPN connection for remote service was 

removed. This function has been replaced with the IBM Virtually On-site 

(VOS) tool. 

v   Information about using the master console with the SAN File System 

was removed.

Changes made in release 3.2 

The following list describes the changes made to the IBM System Storage Master 

Console for SAN Volume Controller: Installation and User’s Guide in release 3.2. 

Note:  The brand ″IBM TotalStorage®″ has been replaced with ″IBM System 

Storage″ when referring to the master console and the SAN Volume 

Controller. 

New information 

New information in release 3.2 of this guide includes: 

v   Information clarifying the version of Tivoli Storage Area Network 

Manger (Tivoli SAN Manager) has been added. 

v   A Windows 2003 example has been added to the instructions for 

mirroring the boot drive. 

v   A new section for upgrading the master console to version 3.2 was 

added. 

v   Several topics about setting up error notifications for the SAN Volume 

Controller were added.

Changed information 

Changed information in release 3.2 of this guide includes: 

v   The information about remote access and the role of the IBM Connection 

Manager in that access has been enhanced. 

v   The conceptual information about service alerts and e-mail notifications 

was updated. 

v   The planning information for the master console has been enhanced and 

updated. 

v   Fibre Channel cables are no longer available with the master console. 

v   The system memory requirements for the hardware where the master 

console is installed is now 4 GB. 

v   The installation overview and several of the installation topics have been 

enhanced and updated. 

v   The configuration overview and most of the existing configuration topics 

were enhanced. 
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v   Some of the troubleshooting information was enhanced or clarified.

Deleted information 

Information that was deleted from release 3.2 of this guide includes: 

v   The hardware master console configuration steps have been removed 

from the planning section and incorporated into the configuring section. 

v   Topics and information related to Fibre Channel connections were 

removed since Fibre Channel connections are no longer available with 

the master console. 

v   The information about setting up service alert for the SAN Volume 

Controller was removed and replaced by several topics about setting up 

error notifications for the SAN Volume Controller 

v   The section for upgrading the master console to version 3.1 was 

removed and replaced with information about upgrading to version 3.2.
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Chapter  1.  Overview  

The master console provides a single point from which to manage the IBM System 

Storage SAN Volume Controller. You can purchase the master console as a 

hardware product option (which includes the master console software 

pre-installed) or as a software-only option. 

The master console provides you with the following functions: 

v   A platform on which the subsystem configuration tools can be run 

v   A platform on which all subsystem service activity can be initiated 

v   E-mail notifications about errors or events to your personnel, such as a systems 

administrator 

v   The call home feature, which is an automatic notification to IBM support staff in 

the event of a severe error 

v   A platform for remote service, which allows the desktop to be shared with 

remote IBM service personnel if assistance is required to resolve complex 

problems 

v   Access to the SAN Volume Controller. You can access the following components: 

–   SAN Volume Controller Console through a Web browser. 

–   Administrative command-line interface, through a Secure Shell (SSH) session.

The  master console can support up to four SAN Volume Controller clusters. 

When using the master console with the SAN Volume Controller, you must install 

and configure the master console before you configure the SAN Volume Controller. 

The installation and configuration steps are different between the hardware master 

console and the software-only master console. For the hardware master console (in 

which the software is preinstalled), you must customize the default factory 

settings. The general steps for this are given in Chapter 5, “Configuring the master 

console,” on page 23. 

A note on the two master console product options 

Although you have two options in purchasing the master console product, 

the only difference between these two options are the installation and 

configuration processes. 

 For the master console software option, you perform both the installation 

and configuration processes. 

 For the master console hardware option, the manufacturing plant installs 

the software on the hardware using the default settings, and you must 

configure and customize the settings.
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Chapter  2.  Concepts  

This section discusses concepts that will help you understand how the master 

console works. Becoming familiar with the master console components and 

understanding the concepts in this section enables you to use the master console 

most effectively. 

Service alerts and error notifications 

This topic provides an overview of the service alerts and error notifications. 

You can configure the IBM Director on the master console to send messages to the 

system administrator through e-mail when errors or events are logged. You can 

also initiate a call home message to IBM when failures that require service actions 

are logged by the SAN Volume Controller. 

In response to a severe error condition, the SAN Volume Controller issues a Simple 

Network Management Protocol (SNMP) trap and sends that trap to the IBM 

Director Server running on the master console. The IBM Director Server catches the 

trap and converts it into a Simple Mail Transfer Protocol (SMTP) e-mail message. 

Two e-mail messages can be produced: one to the systems administrator, and 

another optional e-mail (a call home e-mail) to the IBM support system. The 

optional call home e-mail to the IBM support system is sent to your SMTP mail 

server and then forwarded to the IBM support system, where it is converted into a 

problem record. 

Figure 1 shows the call home architecture for the SAN Volume Controller. 

 

   Related tasks 

   “Installing the SNMP service” on page 13
This topic describes how to install the SNMP services.

Master
console

SMTP
mail

server

IBM RETAIN
support
system

Internet

Customer IBM

SAN Volume
Controllers

s
v
c
0
0
1
8
0

  

Figure 1. Call home architecture for SAN Volume Controller
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Virtually  On-site and remote service 

When you contact IBM to help you resolve a problem with your SAN Volume 

Controller system, the IBM service representative might suggest using IBM 

Virtually On-site (VOS) tool to remotely access the master console. This type of 

remote service can help you reduce service costs and shorten repair times. 

VOS is a remote desktop-sharing solution that is offered through the IBM Web site. 

With it, the IBM service representative can remotely view your system to 

troubleshoot a problem. You can maintain a chat session with the representative, so 

that you can monitor the activity and either understand how to fix the problem 

yourself or allow the IBM service representative to fix it for you. 

To use it, the master console must be able to access the Internet. 

When you access the Web site, you sign in and enter a code that the IBM service 

representative provides to you. This code is unique to each VOS session. A plug-in 

is downloaded onto your master console to connect you and your IBM service 

representative to the remote service session. VOS contains several layers of security 

to protect your applications and your computers. You can also use security features 

to restrict access by the service representative. 

To use VOS, follow the instructions that are given to you by your IBM service 

representative. 

Secure Shell 

This topic provides an overview of Secure Shell (SSH). 

SSH, which is implemented through PuTTY, is the communication vehicle between 

the host system that you are using and the following components: 

v   The SAN Volume Controller command-line interface (CLI) 

v   The master console

SSH provides a secure communications channel between systems. You can 

configure SSH to use a private/public key pair to establish the secure connection. 

This private/public key pair is required for the SAN Volume Controller. 

The SSH key pair must be generated prior to installing the SAN Volume Controller 

Console because you need to enter the key pair during the SAN Volume Controller 

Console installation process. The public key must be placed on any system to 

which you want to create an SSH connection (such as the SAN Volume Controller 

nodes). In addition, any system to which you want to create an SSH connection 

must be running an SSH server. 

Software components 

This topic describes the software components that are provided for the master 

console. 

The following software is provided for the master console: 

v   Adobe Reader 

v   IBM Director 

v   PuTTY (SSH client software) 
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Chapter  3.  Planning  for  the  master  console  

This topic provides an overview of the planning tasks that you must complete 

before you install and configure the master console. 

Note:  The hardware-related prerequisites in this section are relevant only when 

you are installing and configuring the master console software on hardware 

of your choice (that is, when you have purchased only the master console 

software). 

Perform the following steps to plan for the installation of the master console: 

v   Verify that you have met the hardware and software prerequisites if you have 

the software-only master console. 

v   Verify that your planned master console configuration is supported. 

v   Determine how the ports on the master console are to be configured. 

v   Determine the IP addresses to be used for the master console.

The master console must be in the same room as the devices that it supports. In 

addition, place the master console within 50 feet of the SAN Volume Controller 

nodes. 

Prerequisites for the software master console 

Before you install the software master console, ensure that you have the 

prerequisite hardware and software. 

Hardware prerequisites 

The master console software can be installed on a rack-mounted, 

high-performance, highly-reliable Intel® server (such as the IBM eServer™ xSeries® 

306m or equivalent) with the following options: 

v   One Pentium® 4 processor, minimum 2.6 GHz 

v   Minimum of 4 GB of system memory 

v   Two IDE hard disk drives, minimum 40 GB each. During installation, you will 

mirror these drives. 

v   CD drive 

v   One 1 Gb port for an Ethernet connection (fiber or copper) 

v   Keyboard, such as the Space Saver NLS keyboard or equivalent 

v   Monitor, such as Netbay 1U Flat Panel Monitor Console kit without keyboard or 

equivalent 

v   Mouse or equivalent pointing device

Example hardware configuration 

v   IBM xSeries 306m server (1U) 

v   Intel Pentium 4 3.0 GHz processor 

v   4 GB memory DIMM (256 MB comes with base unit) 

v   Two 70 GB IDE hard disk drives (one comes with base unit) 

v   One 10/100/1000 Copper Ethernet port on planar 

 

© Copyright  IBM Corp.  2004, 2006 7

|
|

|

|

|

|

|

|



v   NetBay 1U Flat Panel Monitor Console Kit with US keyboard

Software prerequisites 

The software version of the master console requires that you obtain the following 

software: 

v   Operating system 

–   The software version of the master console requires that one of the following 

operating systems is provided on your hardware platform: 

-   Microsoft Windows Server 2003 Enterprise Edition 

-   Microsoft Windows Server 2003 Standard Edition 

-   Microsoft Windows 2000 Server 5.00.2195.

Note:  The hardware master console is shipped with Microsoft Windows Server 

2003, Standard Edition preinstalled. 

v   Microsoft Windows Internet Explorer version 6.0 with Service Pack 1, or later 

v   Antivirus software (not required but necessary to ensure protection of your 

computer).

Operating System configuration prerequisites 

Ensure that your operating system is configured as follows: 

v   SNMP Service must be installed and set to Automatic. 

v   SNMP Trap Service must be set to Manual.

Supported configurations 

Ensure that your planned master console configuration is one that is supported. 

Use the following rules when planning your master console configuration: 

v   One master console can concurrently support up to four SAN Volume Controller 

clusters. 

v   Multiple master consoles can access a single cluster, but only one master console 

can be configured to support the call home feature for a specific cluster. Also, 

when multiple master consoles access one cluster, you cannot concurrently 

perform configuration and service tasks.

Specifying port assignments 

This topic applies to planning for the hardware master console product. 

If you have completed the planning tasks in the IBM System Storage SAN Volume 

Controller: Planning Guide, you might have assigned two master console Ethernet 

ports: one that connects to the SAN Volume Controller and one to use for a virtual 

private network (VPN) connection. In version 3.1 and earlier version of the master 

console included the IBM Connection Manager, which supported the VPN 

connection as the remote service method. In version 4.1 and later versions, remote 

service is managed by the IBM Virtually On-site (VOS) tool, which is a 

cross-product Internet tool used by IBM and not a component of the master 

console. To use VOS, you must use an Ethernet port that has Internet access. 

However, you can determine how you want to provide the port. For example, you 

can provide the set up and configure the port by using any of the following 

methods: 
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v   Provide Internet access through the same port that is used to access the SAN 

Volume Controller nodes. This method does not provide as much security as the 

other example methods. 

v   Use the alternate Ethernet port that you previously allocated for the VPN 

connection. 

v   Choose not to provide the master console with any access to the public Internet 

and allow VOS to access another console that can access the master console Web 

server over an intranet.

Use Table 1 to record the port assignments. 

 Table 1. Port assignment table 

Master console 

Ethernet 

Ethernet connecting to SAN 

Volume Controller 

(Optional) Ethernet 

connecting to Internet for 

VOS 

  

Table 2 provides an example of a completed port assignment table. 

 Table 2. Example completed port assignment table 

Master console 

Ethernet 

Ethernet connecting to SAN 

Volume Controller 

(Optional) Ethernet 

connecting to Internet for 

VOS 

Master console Ethernet hub 1, port 5 Ethernet hub 1, port 6
  

Specifying IP information 

This topic describes the IP configuration information that you specify for the 

master console. 

Complete the master console IP configuration worksheet for the master console. 

When filling out the port assignment table, use the following descriptions. 

v   Machine name: A fully-qualified Domain Name Server (DNS) name for the 

master console. 

v   Master console IP address: The address that will be used to access the master 

console. 

v   Gateway IP address: The default gateway IP address used by the master 

console. 

v   Subnet mask: The subnet mask for the master console.

Master console IP configuration worksheet 

 Master console IP configuration worksheet 

Machine name: 

Ethernet port 

Master console IP address 

Gateway IP address 

Subnet mask 
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Related tasks 

   “Entering the IP address for the Ethernet port” on page 12
This  topic describes how to configure the IP address for the internal IP network 

connection. You perform this step as part of the installation process for the 

software master console or as part of the configuration process for the hardware 

master console.
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Chapter  4.  Installing  master  console  software  

This section guides you through the process for installing the master console 

software on your own hardware. 

Note:  If you purchased the hardware master console and do not need to reinstall 

the master console software, you can skip the software installation tasks and 

proceed with the steps in the Chapter 5, “Configuring the master console,” 

on page 23 section. 

Before you install the master console software, you must have completed the 

following tasks: 

v   Installed all hardware prerequisites for the master console. 

v   Installed all prerequisite software. 

v   Enabled SNMP services by completing the following steps: 

1.   Click Start → Programs → Control Panel. 

2.   Double-click Add or Remove Programs. 

3.   Select Add/Remove Windows Components. 

4.   Click on the text for Management and Monitoring Tools and click Details. 

5.   Select the Simple Network Management Protocol check box and click OK.

In  addition, view the release notes for the master console software on the following 

IBM support Web site for the latest information: 

http://www.ibm.com/storage/support/2145 

You can use the installation wizard to help you install all of the master console 

software components instead of installing each component individually. 

The following tasks are involved in the master console software installation 

process: 

v   Task 1: Prepare the master console environment. 

v   Task 2: Install the master console software by using the installation wizard. 

v   Task 3: Mirror the boot drive.

Important:  Other than antivirus software, ensure that the master console software 

is the only type of software that is installed on the hardware that you 

are using for the master console. 

Preparing the master console environment 

This topic provides an overview of the steps that are required to set up the master 

console in preparation for installing the master console software. 

To prepare the master console environment, you must perform the following steps. 

These steps are explained in more detail in other topics in this book. 

1.   Configure the IP address for the Ethernet port, which is to be connected to the 

internal IP network. “Entering the IP address for the Ethernet port” on page 12 

provides more details for this step. 

2.   Configure the host name for the master console. “Configuring the master 

console host name” on page 12 provides more details for this step. 
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3.   Set up the internet browser. “Configuring the browser” provides more details 

for this step. 

4.   Install the SNMP service (if you did not install it when you installed the 

operating system). “Installing the SNMP service” on page 13 provides more 

details for this step.

Entering the IP address for the Ethernet port 

This topic describes how to configure the IP address for the internal IP network 

connection. You perform this step as part of the installation process for the 

software master console or as part of the configuration process for the hardware 

master console. 

Perform the following steps to configure the IP address for the internal network 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 

6.   Click Properties. 

7.   Type all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 

9.   Connect the Ethernet port to the network. 

   Related reference 

   “Specifying IP information” on page 9
This topic describes the IP configuration information that you specify for the 

master console.

Configuring the master console host name 

You must set up the master console host name using the IP configuration 

information that you have specified during planning. 

Perform the following steps to configure the host name: 

1.   From the desktop, right-click the My Computer icon and select Properties. 

2.   Click the Network Identification tab. 

3.   Click Properties. 

4.   Enter the master console name in the Computer name field. 

5.   Click More. 

6.   Enter the full path information in the Primary DNS suffix for this computer 

field. 

7.   Click OK until you return to the desktop.

Configuring the browser 

After you install the SAN Volume Controller components, you can connect to the 

SAN Volume Controller Console using any supported Web browser on your 

system that is correctly configured. 

Perform the following steps to configure the browser: 
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1.   Ensure that the browser settings allow new windows (pop-ups) to 

automatically open when you visit a Web site. 

2.   Uninstall or turn off any applications on the system that cause the browser to 

block or suppress pop-up windows. 

Your browser is now configured to use the SAN Volume Controller Console. 

Installing the SNMP service 

This topic describes how to install the SNMP services. 

You must install the SNMP service if it was not installed when you installed the 

operating system. Perform the following steps to install the SNMP service: 

 1.   Click Start-->Settings-->Control Panel. 

 2.   Double-click Add/Remove Programs. 

 3.   Click Add/Remove Windows components on the left side of the panel. 

 4.   Click Management and Monitoring Tools, and then click Details. 

 5.   Check Simple Network Management Protocol, and click OK. 

 6.   Click Next to complete the installation process. 

 7.   From the Control Panel, double-click Administrative Tools. 

 8.   Double-click Computer Management. 

 9.   Expand Services and Applications. 

10.   Click Services. 

11.   In the list of services, double-click SNMP Service. 

12.   Click the General tab and select Automatic as the startup type. 

13.   Click the Security tab and perform the following actions: 

a.   Click Add under the Accepted Community Names field, enter public as 

the new community name, and leave the community rights as read-only. 

b.   Ensure that the Accept SNMP packets from any host option is selected. 

Note:  On some operating systems, the default is Accept SNMP packets 

from these hosts, with an empty field underneath for you to specify 

certain hosts. This option causes the NetView® part of the 

installation to fail.
   Related concepts 

   “Service alerts and error notifications” on page 3
This  topic provides an overview of the service alerts and error notifications.

Using the installation wizard 

This topic describes the installation process and lists the programs that you can 

install using the installation wizard. 

The master console installation wizard provides the framework for installing all the 

required software for the master console. It ensures that the master console meets 

all prerequisites and launches the installation program for each software 

component that is being installed.

Important:  During the installation process, some products require a system reboot 

after they are installed. Reboot the system any time that you are 

prompted to do so. After each system reboot, the master console 

 

Chapter  4. Installing master console  software 13



installation wizard continues the installation process from the point 

where it was interrupted by the required reboot. 

The installation wizard helps you to install the following products: 

v   Adobe Reader 

v   PuTTY 

v   SAN Volume Controller Console (optional) 

v   IBM Director

You must use the master console CD-ROMs to install the master console software. 

Logging in 

This topic describes the permissions that are required to perform the master 

console installation. 

To begin installing software on the master console, you must be logged in as a 

local administrator (for example, as the Administrator user) on the system where 

the master console software is to be installed. 

Starting the installation wizard 

This topic describes the steps for starting the installation wizard. 

Before you begin the installation wizard, ensure that you have logged in with a 

user ID that has administrative privileges. 

Perform the following steps to start the installation wizard: 

1.   Insert the master console CD-ROM 1 in the CD-ROM drive. 

2.   Click Start—>Run to open the Run dialog. 

3.   Enter cd-rom_drive:\setup.exe, where cd-rom_drive is the letter of the drive in 

which you inserted the CD. Click OK. 

The following message is displayed in a window: 

+---------------------------------------------------------------+ 

| InstallShield(R) is preparing the InstallShield Wizard, which | 

| will guide you through the rest of the process.               | 

| Please wait .........                                         | 

|                                                               | 

| Preparing Java (tm) Virtual Machine                           | 

+--------------------------------------------------------------+ 

4.   When you are prompted, select the language to be used for the installation 

wizard and click OK. 

5.   The installation wizard Welcome panel is displayed. Read the information from 

the panel and then click Next. 

6.   The installation wizard License Agreement panel is displayed. Click I accept 

the terms in the license agreement, and then click Next to begin installing the 

Adobe Reader. 

Note:  Before Adobe Reader is installed, the program performs the following 

checks: 

a.   The installation wizard verifies that all software prerequisites are 

installed on the system. If not, a window opens that describes the 

prerequisite software that is not currently installed. When you click 

OK, the installation wizard ends. 

After installing the prerequisite software, start the installation wizard 

again. 
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b.   If any hardware requirements are not met on your system, a panel is 

displayed that states that the hardware requirements are not met and 

warns about a decrease in the performance level if these requirements 

are not met.

Installing the Adobe Reader 

This topic describes how to install the Adobe Reader using the master console 

installation wizard. 

Adobe Reader is silently installed by the installation wizard. It allows you to open 

online versions of documentation, such as this document, through a pop-up 

window. 

From the Install Acrobat Reader panel of the wizard, click Next to start the 

installation of Adobe Reader. 

When the installation is complete, the Useful Information panel is displayed. From 

this panel, you can access this document or IBM Support Web sites by following 

the instructions on the panel. 

Click Next to select the destination directory where you want the master console to 

be installed. 

Choosing the master console destination directory 

This topic describes how to specify the installation directory for the master console 

software when you use the installation wizard. 

Perform the following steps to choose the destination directory: 

1.   By default, the master console is installed in C:\Program Files\IBM\
MasterConsole. To choose a different directory, click Browse and select a 

different directory from the Select a directory dialog box. 

2.   After you specify the destination directory, click Next.

Selecting the port for the information center 

This topic describes how to select the port value that accesses the master console 

information center. 

Perform the following steps to select a port value: 

1.   Enter a port value between 1 and 65535. To ensure that the port value is not in 

use by another application on your system, open a command prompt and enter 

the command netstat –a to see which port values are in use. 

2.   After entering the information center port value, click Next to display the list of 

optional products that you can select to be installed for the master console.

Selecting the optional features 

This topic describes how to select the optional features to be installed by the 

master console installation wizard. 

Perform the following steps to specify whether you want to install the SAN 

Volume Controller Console: 

1.   Select SAN Volume Controller Console if you want to install that feature. 

Otherwise clear the check box. 
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If you clear the SAN Volume Controller Console check box, a message is 

displayed when you click Next that warns you that you must install this 

feature if the SAN Volume Controller Console is part of the current 

configuration. 

2.   Click Next to display the list of products that are to be installed for the master 

console.

Viewing  the products to be installed 

This topic describes the panel that displays the list of products to be installed for 

the master console, and it explains the next steps in the master console installation 

process. 

Using the list of products to be installed for the master console, the installation 

wizard determines if any of these products are already installed and, if so, whether 

the installed version is a later version than the version to be installed. The Product 

List panel lists the following results: 

v   Products of the master console stack 

v   Versions of already-installed products 

v   Required versions for the products 

v   Actions to be done by the installation wizard or by you

The  table containing the list of the products to be installed or upgraded is saved as 

MasterConsoleProducts.htm in the location where the master console is installed. 

Depending on the installed version of each product, the installation wizard 

determines whether to install the product based on the following conditions: 

v   If the product is not installed or its installed version is lower than the desired 

version, the product is installed or upgraded by launching the specific installer 

of the product. 

v   If the product is installed at a version equal to or higher than the desired 

version, the product is left as it is. The corresponding panels that launch and 

verify the specific product installation are skipped. For the products with higher 

versions than the required ones, the installation wizard displays a warning that 

tells you that these products are not tested with the master console. 

v   If a product in the list of products to be installed or upgraded is not properly 

installed on the system, you are asked to continue with the installation by 

reinstalling the product with the product-specific installer. If this action does not 

succeed, you must exit the master console installation wizard, manually remove 

the product from your system, and restart the master console installation wizard.

After you have reviewed the information presented in the table on this panel, click 

Next. 

Installing PuTTY 

This topic describes how to install PuTTY using the master console installation 

wizard. PuTTY is the SSH client software used by the master console. 

Perform the following steps to install PuTTY: 

1.   From the PuTTY installation panel, click Next to begin the installation of 

PuTTY. 

2.   The installation wizard installs PuTTY silently. Wait for the wizard to complete 

the installation. 
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3.   From the master console installation wizard, click Next. The installation wizard 

validates the installation of PuTTY. If the validation is not successful, an error 

panel is displayed. If errors were found, correct the errors and start the 

installation wizard again. 

Before you continue with the installation wizard, create an SSH key pair using 

PuTTYgen. You need these keys when you install the SAN Volume Controller 

Console. 

Generating an SSH key pair using PuTTYgen 

Although not part of the master console installation wizard, you must generate 

SSH keys for the SAN Volume Controller. You are prompted for these keys when 

you install the SAN Volume Controller Console. You can leave the installation 

wizard in its current state while you generate the SSH keys. 

Perform the following steps to generate SSH keys on the master console using the 

PuTTY Key Generator (PuTTYgen): 

 1.   Start PuTTYgen by clicking Start → Programs → PuTTY → PuTTYgen. 

 2.   Click SSH2 RSA as the type of key to be generated. 

 3.   Click Generate. 

 4.   Move the cursor around the blank area of the Key section to generate a 

random number. 

 5.   Click Save public key to save the public key. 

 6.   Type icat as the name of the public key and click OK. 

 7.   Click Save private key to save the private key. 

 8.   When you are prompted to confirm that you want to create the key without a 

passphrase, click Yes. 

 9.   Type icat.ppk as the name of the private key and click OK. 

10.   Close PuTTYgen.

Installing SAN Volume  Controller Console 

This topic describes how to install the SAN Volume Controller Console by using 

the master console installation wizard. 

Perform the following steps to install the SAN Volume Controller Console: 

1.   From the master console installation wizard, click Next to launch the SAN 

Volume Controller Installer wizard. 

2.   From the SAN Volume Controller Installer wizard, perform these steps to 

install the SAN Volume Controller Console: 

a.   From the Welcome panel, click Next. 

b.   From the License Agreement panel, click I accept the terms of the license 

agreement, and then click Next. 

c.   From the Destination Directory panel, click Next to accept the default 

directory. 

d.   From the PuTTY configuration panel, enter the private key (default is 

icat.ppk) that you created after installing PuTTY. Then, click Next. 

e.   From the CIMOM ports panel, click Next to accept the default ports. 

f.   From the embedded WebSphere® Application Server ports panel, click Next 

to accept the default ports. 

g.   From the installation confirmation panel, click Install to install the SAN 

Volume Controller Console. 
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h.   Click Finish to complete the installation. 

Note:  If you click View post installation tasks, you can view the steps 

needed to access the SAN Volume Controller Console.
3.   From the master console installation wizard, click Next. 

The master console installation wizard validates the installation of the SAN 

Volume Controller Console. If the validation is not successful, an error panel is 

displayed. If errors were found, correct the errors and start the installation 

wizard again.

Installing IBM Director 

This topic describes how to install IBM Director using the master console 

installation wizard. 

Perform the following steps to install IBM Director: 

1.   From the master console installation wizard, click Next to begin the installation 

of IBM Director. 

2.   If you are prompted to insert a different CD, insert it in the CD-ROM drive and 

enter the CD-ROM drive letter in the location field. Then click OK. 

The IBM Director Setup Wizard is launched. 

3.   From the Setup Wizard, perform the following steps to install IBM Director: 

a.   From the Welcome panel, click Next. 

b.   From the License Agreement panel, click I accept the terms in the License 

Agreement, and click Next. 

c.   From the Feature and Installation Directory panel, click the Red x for SNMP 

Access and Trap Forwarding. Click This Feature will be installed on the 

local hard drive, and click Next. 

d.   From the IBM Director service account information panel, fill in the 

following fields: 

v   Domain: Enter the host name for the master console. 

v   User name: Enter a Windows user account that has administrative 

privileges. 

v   Password: Enter the password for the Windows user account (and 

confirm it). 

Click Next. 

e.   From the Encryption Settings panel, click Next to accept the defaults. 

f.   From the Software distribution settings panel, click Next to accept the 

defaults. 

g.   Click Install to begin the installation. 

h.   From the Network Drivers configuration window, select the first port and 

click Enable driver. 

i.   From the IBM Director database configuration, make sure that Apache 

Derby, which is the default, is selected. Then click Next. 

j.   From the IBM Director Apache Derby database configuration, click Next 

because you cannot change any of the Apache Derby database configuration 

values. 

k.   Click Finish to complete the installation. 

l.   When you are prompted to restart the system, click Yes.
4.   From the master console installation wizard, click Next. The master console 

installation wizard validates the installation of IBM Director. If the validation is 
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not successful, the Verify IBM Director Installation panel displays an error. 

Correct all errors and restart the master console installation wizard.

Preconfiguring IBM Director 

This topic describes how the master console installation wizard performs some 

preconfiguration tasks for IBM Director. 

IBM Director preconfiguration tasks consist of creating a set of event action plans 

designated for managing specific events generated by the master console system. 

These action plans are imported from configuration archive files that should exist 

on the master console installation package. 

Perform the following steps to launch the IBM Director preconfiguration tasks: 

1.   If at least one of the event action plans is in the installation package, you are 

asked to provide, in the Superuser account panel, a Director superuser 

(member of DirSuper group) name and password needed in the IBM Director 

preconfiguration process. 

Provide the name and password, and click Next to continue. 

2.   Wait for the master console wizard to restart IBM Director and to discover IBM 

Director-managed systems. 

3.   The installation wizard finishes the preconfiguration tasks. If one or more 

configuration files are not found in the installation package, or if an error 

occurs during the creation of event action plans, a message is displayed in a 

panel warning the user that these action plans must be manually created later, 

after the installation is completed. 

Click Next to continue. 

After the master console installation wizard has completed the preconfiguration 

tasks for IBM Director, you need to complete the following steps to ensure that the 

local system account can log on to IBM Director: 

 1.   Close IBM Director. 

 2.   Right-click My Computer from the desktop, and then click Manage. 

 3.   Expand Services and Applications. 

 4.   Click Services. 

 5.   Right-click IBM Director Server and click Properties. 

 6.   Select the Log On tab. 

 7.   Click Local System account and select Allow service to interact with 

desktop. Click Apply. 

 8.   You are prompted that the new properties will not take effect until you stop 

and restart the service. Click OK at the prompt. 

 9.   Click OK to close the Properties dialog. 

10.   Stop the IBM Director service, and then restart it.

Installing documentation and support utilities 

This topic describes how to use the master console installation wizard to install the 

master console documentation, Document Launcher, configuration files, IBM 

WebSphere Help System, and create the directories structure and icons. 

Perform the following steps to copy the documentation files and to install the 

utilities: 
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1.   From the master console installation wizard, click Next to begin installing the 

documentation and support utilities. 

2.   If prompted to insert a different CD, insert it in the CD-ROM drive and enter 

the CD-ROM drive letter in the location field. Then click OK. 

3.   The documentation and support utilities are copied. 

4.   The installation wizard copies Eclipse files of IBM WebSphere Help System and 

installs the master console information center (copies master console-specific 

documentation into the IBM WebSphere Help System). 

5.   The program installs the master console information center as a service. 

6.   After all documentation and utilities are installed, the Finish panel is displayed. 

7.   Review the master console installation log (mclog.txt) to ensure that all 

products are properly installed. The log file is located in 

<installation_directory>\logs, where <installation_directory> is the directory where 

the master console was installed. The default installation directory is 

C:\Program Files\IBM\MasterConsole. 

8.   Click Finish to complete the installation. 

9.   If a system reboot is required, accept the prompt to complete the master 

console installation process.

Mirroring the boot drive 

You can use the Microsoft Windows software mirroring capability to mirror the 

boot drive on the master console. 

Before you mirror the boot drive, ensure that you meet the following prerequisites: 

v   You must have a second drive that is as large or larger than your original boot 

drive. 

v   If the target disk has a partition that is assigned to it (that is, it already has a 

drive letter), perform the following steps to remove the partition: 

1.   Back up any necessary data on the existing partition. When you remove an 

existing partition, you lose any data that is on it. 

2.   Remove the partitioning by right-clicking My Computer, selecting Manage → 

Storage → Disk Management, right-clicking the target disk drive, and then 

selecting Delete Partition.

Perform the following steps to mirror the boot drive: 

 1.   Right-click My Computer on the desktop. 

 2.   Click Manage. 

 3.   Click Storage → Disk Management. 

 4.   Right-click the disk icon for the system disk. 

 5.   Convert the disk to a dynamic disk by performing the following actions: 

For Windows 2000 systems: 

a.   Click Upgrade to dynamic disk and then click OK. 

b.   Right-click the disk icon for the disk that you want to become the mirror 

of the system disk. 

c.   Click Upgrade to dynamic disk and then click OK. 

d.   If you receive a warning, click Yes. 

e.   If your system restarts, restart the Disk Management utility. 

For Windows 2003 systems: 

a.   Click Convert to dynamic disk. 
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b.   Select both drives and click OK. 

c.   Click Convert. 

d.   Click Yes to continue when you receive an operating system boot warning. 

e.   Click Yes to unmount file systems and to continue. 

f.   Allow the system to reboot. 

g.   Restart the Disk Management utility
 6.   For Windows 2000 systems, right-click the disk icon for the system disk or, for 

Windows 2003 systems, right-click the system disk partition. 

 7.   Click Add Mirror. 

 8.   Select the disk that you want to become the mirror of the system disk, and 

then click Add Mirror. 

 9.   Click OK to continue when you receive a warning indicating that you must 

update the boot.ini file. 

10.   Perform the following steps to update the boot.ini file: 

a.   Double-click My Computer on the desktop. 

b.   Click Tools → Folder options. 

c.   Click the View tab. 

d.   In the Advanced settings list, perform one of the following actions, 

depending on your operating system: 

v   For Windows 2000 systems, select Show hidden files and folders. 

v   For Windows 2003 systems, select Show hidden files and folders and 

clear the Hide protected operating system files option. Click Yes when 

you receive a warning.
e.   In the My Computer window, click Local disk (C:). 

f.   Open the C:\boot.ini file in a text editor. 

Attention: Be cautious when you edit this file and make only the specified 

changes. Do not modify any other lines in this file. 

g.   In the operating system section, add Primary to the end of the operating 

description for the system disk. 

h.   Copy the line for the system disk, change Primary to Secondary, and 

change the system disk (for example, rdisk(0)) to mirrored disk (for 

example, rdisk(1)). The file looks similar to one of following examples. 

Windows 2000 example: 

[boot loader] 

timeout=30 default=multi(0)disk(0)rdisk(0)partition(1)\WINNT 

[operating systems] 

multi(0)disk(0)rdisk(0)partition(1)\WINNT="Microsoft Windows 2000 Advanced 

  Server Primary" /fastdetect 

multi(0)disk(0)rdisk(1)partition(1)\WINNT="Microsoft Windows 2000 Advanced 

  Server Secondary" /fastdetect

 

Windows 2003 example: 

[boot loader] 

timeout=30 

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS 

[operating systems] 

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows Server 2003, 

  Standard Primary" /fastdetect 

multi(0)disk(0)rdisk(1)partition(1)\WINDOWS="Windows Server 2003, 

  Standard Secondary" /fastdetect

 

i.   Save and close the file. 
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j.   Restart the machine. 

After the machine completes the Power On Self Test (POST), the system 

prompts you to select the Windows operating system to use for the boot 

process 

k.   Select the secondary operating system and press Enter to verify that the 

machine successfully restarts from the mirrored drive. 

l.   Restart the machine again. 

After the machine completes the POST, the system again prompts you to 

select the Microsoft Windows operating system to use for the boot process. 

m.   Select your operating system and press Enter to verify that the machine 

successfully restarts from the system drive.

 

22 Master Console  Installation and User’s Guide



Chapter  5.  Configuring  the  master  console  

This section provides steps for configuring the master console. If you installed the 

master console on your own hardware, you have already performed some of these 

steps during the installation process. 

Perform the following process to configure your master console: 

1.   Log on as a local administrator (for example, as the Administrator user) to the 

system where the master console software is installed. 

Note:  If you purchased the software-only master console, skip to step 3 

because you completed steps 2a through 2d when you installed the 

master console software. 

2.   If you purchased a hardware master console, perform the following 

configuration steps: 

a.   Optionally, reconfigure the master console host name. When you receive the 

hardware master console, the host name is preconfigured as mannode. If you 

choose to change this name see “Reconfiguring the master console host 

name” for more information. 

b.   Configure the network. “Configuring the network” on page 24 provides 

more details for this step. 

c.   Configure the browser. “Configuring the browser” on page 24 provides 

more details for this step. 

d.   Generate an SSH key pair using the PuTTYgen. “Generating an SSH key 

pair using PuTTYgen” on page 17 provides more details for this step.
3.   For both software and hardware master consoles, perform the following 

configuration steps: 

a.   Configure a default PuTTY session only for command-line interface (CLI) 

access. “Configuring a default PuTTY session” on page 25 provides more 

details for this step. 

b.   Store keys in the SAN Volume Controller Console software. “Storing keys in 

the SAN Volume Controller Console software” on page 26 provides more 

details for this step. 

c.   Set up e-mail notification and the call home feature for the SAN Volume 

Controller. “Setting up e-mail notification for the SAN Volume Controller” 

on page 26 and “Setting up the call home feature for the SAN Volume 

Controller” on page 28 provide more details for this step. 

d.   Install your chosen antivirus software on the master console system.

Reconfiguring the master console host name 

When you receive the hardware master console, the host name is preconfigured as 

mannode. However, you can reconfigure the master console host name as part of the 

configuration process for the hardware master console. 

Perform the following steps to reconfigure the host name: 

 1.   From the desktop, click Start. 

 2.   Right-click on My Computer. 

 3.   Click Properties. 
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4.   Click Computer Name. 

 5.   Click Change. 

 6.   Type the master console host name in the Computer name field. 

 7.   Click More. 

 8.   Type the full path information in the Primary DNS suffix of this computer 

field. 

 9.   Click OK until you return to the desktop. 

10.   Run the install_path\MasterConsole\Support Utils\mcconfig.exe file, where 

install_path is the drive letter and the directory where the master console is 

installed.

Configuring the network 

You must configure the network as part of the installation process for the software 

master console or as part of the configuration process for the hardware master 

console. 

Entering the IP address for the Ethernet port 

This topic describes how to configure the IP address for the internal IP network 

connection. You perform this step as part of the installation process for the 

software master console or as part of the configuration process for the hardware 

master console. 

Perform the following steps to configure the IP address for the internal network 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 

6.   Click Properties. 

7.   Type all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 

9.   Connect the Ethernet port to the network. 

   Related reference 

   “Specifying IP information” on page 9
This topic describes the IP configuration information that you specify for the 

master console.

Configuring the browser 

If you plan to access the SAN Volume Controller Console using a browser other 

than the one that is preinstalled on the hardware master console system, use the 

configuration instructions of your chosen browser to ensure that new windows 

(pop-ups) can automatically open when you visit a Web site. Also, uninstall or turn 

off any applications that block or suppress pop-up windows. 
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Generating an SSH key pair using PuTTYgen 

You must generate SSH keys for the SAN Volume Controller as part of the 

installation process for the software master console or as part of the configuration 

process for the hardware master console. 

Perform the following steps to generate SSH keys on the master console using the 

PuTTY Key Generator (PuTTYgen): 

 1.   Start PuTTYgen by clicking Start —>Programs —> PuTTY —> PuTTYgen. 

 2.   Click SSH2 RSA as the type of key to be generated. 

 3.   Click Generate. 

 4.   Move the cursor around the blank area of the Key section to generate a 

random number. 

 5.   Click Save public key to save the public key. 

 6.   Type icat as the name of the key and click OK. 

 7.   Click Save private key to save the private key. 

 8.   When you are prompted to confirm that you want to create the key without a 

passphrase, click Yes. 

 9.   Type icat.ppk as the name of the key and click OK. 

10.   Close the PuTTYgen.

Configuring a default PuTTY session 

For both the software and hardware versions of the master console, you must 

configure a default PuTTY session so that you can run SSH from a command-line 

interface. 

You must perform these steps only if you are planning to run the PuTTY from a 

command prompt window and you are using private and public keys. 

Perform these steps to configure the PuTTY session on the master console: 

 1.   Click Start —>Programs —> PuTTY —> PuTTY to open the PuTTY 

Configuration GUI window. 

 2.   In the categories pane, make sure that Session is selected. 

 3.   Select SSH as the protocol under the PuTTY basic options. 

 4.   In the categories pane, click Connection —> SSH. 

 5.   Select 2 as the preferred SSH protocol version. 

 6.   In the categories pane, click Auth. 

 7.   Type the fully-qualified file name of the SSH client private key file that you 

specified when you used the PuTTY Key Generator in the Private key file for 

authentication field in the Authentication Parameters. For example, 

C:\Support Utils\PuTTY\icat.ppk. 

If you do not know the file name, you can click Browse to select the file name 

from the system directory. 

 8.   In the categories pane, click Session. 

 9.   In the Saved Sessions window, click Default Settings. 

10.   Click Save to save your settings.
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Storing keys in the SAN Volume  Controller Console software 

For both the software and hardware versions of the master console, when the keys 

that are used to communicate with the SAN Volume Controller are generated or 

changed, you must store a copy of the new private key in the SAN Volume 

Controller Console software. 

Perform the following steps to store a copy of the new private key in the SAN 

Volume Controller Console software: 

1.   Open a command prompt window by clicking Start —>Run. 

2.   Type cmd.exe in the Open box. Click OK. 

3.   Type the following command: 

copy path\icat.ppk C:\″Program Files″\IBM\svcconsole\cimom 

where path is the path where you stored the SSH private key when it was 

generated.

Note:  Directory names with embedded spaces must be surrounded by double 

quotation marks. 

4.   Stop and start the IBM CIM Object Manager to make the change take effect. 

Perform the following: 

a.   Click Start —>Settings —> Control Panel. 

b.   Double-click Administrative Tools. 

c.   Double-click Services. 

d.   From the list of services, right-click IBM CIM Object Manager. Select Stop 

and wait for Windows to stop the service 

e.   From the list of services, right-click IBM CIM Object Manager. Select Start.

Configuring the error notification and call home features for the SAN 

Volume  Controller 

For both the software and hardware versions of the master console, you must 

configure the error notification and call home features for the SAN Volume 

Controller if you plan to use these options. 

Before you perform these procedures, ensure that the following prerequisites are 

met: 

v   The SAN Volume Controller must be installed and configured. 

v   You must know the serial number of the SAN Volume Controller.

The IBM Director provides error notification by alerting your system administrator 

through e-mail when errors or events are logged by the SAN Volume Controller. 

The call home feature initiates a message to IBM when failures that require service 

actions are logged by the SAN Volume Controller. 

Setting up e-mail notification for the SAN Volume  Controller 

If you use the e-mail notification feature on either the software and hardware 

versions of the master console, you must perform this task to configure IBM 

Director to alert your system administrator by e-mail when errors or events are 

logged by the SAN Volume Controller. 
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Perform the following steps to configure the IBM Director to notify your system 

administrator of SAN Volume Controller errors and events: 

 1.   Initiate a test SNMP trap to be sent to the master console IP address by 

causing a temporary error on the SAN Volume Controller. For example, 

temporarily remove one of the SAN Volume Controller fibre-channel cables to 

cause error code 1060 to be displayed on the front panel of the SAN Volume 

Controller node. After this error is displayed, replace the fibre-channel cable, 

and delete the entry in the SAN Volume Controller error log. 

 2.   Log on to the master console. 

 3.   From the desktop, double-click the IBM Director console icon to open the 

IBM Director console. 

 4.   Log on to the IBM Director console. 

 5.   Validate that the IBM Director received the test trap that was sent by the SAN 

Volume Controller by using the following steps: 

a.   Open the Event Log by clicking Tasks → Event Log → Event Log: Open. 

b.   Verify that the test SNMP trap was received. SAN Volume Controller traps 

can be identified by displaying the Event Type field of the log. For SAN 

Volume Controller traps, the field contains text starting with 

SNMP.iso.org.dod.internet.private.enterprises.ibm.ibmProd.190. If the test 

trap was not received, perform one or more of the following actions: 

v   Contact your network administrator to ensure that there is not a 

networking problem. 

v   Verify that the error notification setting on the SAN Volume Controller is 

not set to none. 

v   Verify that the master console IP address has been configured.
c.   Close the Event Log.

 6.   From the IBM Director main panel, click Tasks→Event Action Plan Builder. 

The Event Action Plan Builder panel opens. 

 7.   Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of 

the Event Action Plan Builder panel. 

 8.   Double-click 2145EventNot. 

 9.   Type the following information in the form that is displayed: 

a.   Internet E-mail Address: Type an e-mail address (for example, the e-mail 

address of the system administrator). 

b.   Reply to: Type the e-mail address to which you want replies to be 

directed. 

c.   SMTP E-mail server: Type the name or IP address of the SMTP mail 

server. 

d.   SMTP port: Type the port number through which e-mail is sent to your 

e-mail server. The default is 25. 

e.   Subject of E-mail Message: Type 2145 Event Notification. 

f.   Body of E-mail Message: Type any information that you want to be sent to 

the recipient of the e-mail (for example, the machine location information). 

The body of the e-mail also contains all the SNMP trap data that contains 

the details of the event.
10.   Click File->Save. 

11.   Close the Event Action Plan Builder panel. 

12.   Close the main IBM Director panel.
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Setting up the call home feature for the SAN Volume  

Controller 

If you use the call home feature on either the software and hardware versions of 

the master console, you must configure the IBM Director to initiate a message to 

IBM when failures that require service actions are logged by the SAN Volume 

Controller. 

Perform the following steps to configure the master console to support the call 

home feature: 

 1.   Log on to the master console. 

 2.   From the desktop, double-click the IBM Director console icon to open the 

IBM Director console. 

 3.   Log on to the IBM Director console. 

 4.   From the IBM Director main panel, click Tasks → Event Action Plan Builder. 

The Event Action Plan Builder panel opens. 

 5.   Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of 

the Event Action Plan Builder panel. 

 6.   Double-click 2145CallHome. 

 7.   Type the following information in the form that is displayed: 

a.   Internet E-mail Address: If the SAN Volume Controller is located in North 

America, Latin America, South America or the Caribbean Islands, type the 

following address into the field: 

callhome1@de.ibm.com 

If the SAN Volume Controller is located anywhere else in the world, type 

the following address into the field: 

callhome0@de.ibm.com 

b.   Reply to: Type the e-mail address to which you want replies to be 

directed. 

c.   SMTP E-mail server: Type the name or IP address of the SMTP mail 

server. 

d.   SMTP port: Type the port number through which e-mail is sent to your 

e-mail server. The default is 25. 

e.   Subject of E-mail Message: Type 2145 Error Notification 

f.   Body of E-mail Message: Complete the following text fields. Do not 

change any other fields in the body of the e-mail message. 

# Contact name = contact_name 

# Contact phone number = primary_telephone_number 

# Offshift phone number = offshift_telephone_number 

# Machine location = machine_location 

where contact_name is the name of the person who the IBM service 

representative can contact about this call home request, 

primary_telephone_number is the primary telephone number to use to reach 

the contact person, offshift_telephone_number is the telephone number where 

the contact person can be reached during nonbusiness hours, and 

machine_location is the location of the machine. You can enter a maximum 

of 72 characters for each field.
 8.   Click File → Save. 

 9.   Double-click 2145Test. 
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10.   In the Body of E-mail Message section of the form that displays, type the 

same information that you entered in step 7f on page 28 along with the 

following information: 

# Machine Type/Model = type_model 

# Serial Number = serial_number 

where: 

v   type_model is the machine type and model of the installed SAN Volume 

Controller that is involved in this call home request. Possible values for 

type_model are 21454F2 (default), 21458F2, and 21458F4. The default value is 

21454F2. Do not enter any hyphens when you type the machine type and 

model. 

v   serial_number is the serial number of the SAN Volume Controller that is 

involved in this call home request. To find the value for serial_number on 

4F2 models, find the serial number label, which is located on the right edge 

of the front panel. For the 8F2 and the 8F4 models, the label is located on 

the center of the front panel. Do not enter any hyphens when you type the 

serial number.
11.   Click File → Save. 

12.   Right-click 2145Test and select Test. 

A call home record is generated. An IBM service representative will call you 

within 24 hours to confirm that the call home test has been successful. If you 

do not receive a phone call, report this to IBM as a call home failure. 

13.   Close the Event Action Plan Builder panel. 

14.   Close the main IBM Director panel. 

Note:  The action plan is preconfigured. If this becomes corrupted, the call 

home function and event notifications will fail and, before you 

continue, you must recover the data.
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Chapter  6.  Managing  the  master  console  

This section provides an overview of the tasks that you can perform from the 

master console. 

Tasks that you can perform from the master console include: 

v   Recovering Action Plan preconfiguration data 

v   Replacing the SSH key pair for SAN Volume Controller 

v   Replacing the client SSH private key known to the SAN Volume Controller 

software 

v   Setting passwords for the SAN Volume Controller. 

v   Changing the master console host name.

Recovering Action Plan preconfiguration data 

IBM Director is preconfigured to help you set up error notification for the SAN 

Volume Controller. If this preconfiguration data becomes corrupted, the call home 

function and event notifications fail. 

Use the following Web site to download the most recent SAN Volume Controller 

Management Information Base (MIB) and preconfiguration recovery files and 

procedures: 

http://www.ibm.com/storage/support/2145 

Note:  Although preconfiguration recovery files exist on the master console, these 

files might not be compatible with the latest version of SAN Volume 

Controller software or with the latest SAN Volume Controller MIB. 

Replacing the SSH key pair for the SAN Volume  Controller 

This topic provides step-by-step instructions for replacing the SSH key pair. 

Note:  

v   If you change the SSH keys that will be used by the master console to 

communicate with the SAN Volume Controller Console, you will have to 

store the client SSH private key in the SAN Volume Controller Console 

software as described previously and then store the client SSH public key 

on the SAN Volume Controller cluster. 

v   If you change the IP address of your SAN Volume Controller cluster after 

you have added the cluster to SAN Volume Controller Console, the SAN 

Volume Controller Console will not be aware of the existence of the 

cluster.

To correct this, remove the cluster from the SAN Volume Controller Console and 

add it back again. Perform the following steps: 

 1.   Start the SAN Volume Controller Console by clicking on the desktop icon or 

by using your Web browser to go to http://IP_address:9080/ica, where 

IP_address is the IP address of the master console. The Signon window is 

displayed. This might take a few moments to open. 

 2.   Enter the user ID superuser and the password passw0rd. The Welcome 

window is displayed. 
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3.   Click Clusters from the portfolio. 

 4.   Check the Select box for the cluster for which you wish to replace the key. 

 5.   Click Remove a cluster in the selection box 

 6.   Click Go. 

 7.   Click Clusters from the portfolio. 

 8.   Click Add a cluster in the selection box. 

 9.   Input the IP address of the cluster. 

10.   Do not check the Create (Initialize Cluster) box. 

11.   Click OK. 

12.   Enter the user name and password. When you see the pop-up window, enter 

the network password and click OK. 

13.   Add the SSH client public key to the SAN Volume Controller cluster: 

a.   Click Browse... for the key file to upload and locate the public key or 

input the key in the Key (direct input) field 

b.   Type an identifier in the ID field, which uniquely identifies the key to the 

cluster. 

c.   Select the Administrator radio button. 

d.   Click Add Key. 

e.   Click Clusters from the portfolio to check the status of the cluster. If the 

cluster status remains SSH Key Refused, you do not have a good key 

pair. You can reset the SAN Volume Controller Console private SSH key. 

However, if you have successfully contacted other clusters, you will break 

that connectivity.

Replacing the client SSH private key known to the SAN Volume  

Controller software 

This task provides step-by-step instructions to replace the client SSH private key 

known to the SAN Volume Controller software. 

Attention:  If you have successfully contacted other SAN Volume Controller 

clusters, you will break that connectivity if you replace the client SSH private key 

known to the SAN Volume Controller software. 

Perform the following steps to replace the client SSH private key: 

1.   Sign off the SAN Volume Controller Console. 

2.   Using the Windows Services facility, stop the IBM CIM Object Manager: 

a.   Click Start —> Settings —> Control Panel. 

b.   Double-click Administrative Tools. 

c.   Double-click Services. 

d.   Select IBM CIM Object Manager in the list of services, right click, and 

select Stop. 

e.   Leave the Services panel open.
3.   Copy the client SSH private key into the appropriate SAN Volume Controller 

Console directory. Perform the following: 

a.   Open a command prompt window by clicking Start —> Run. 

b.   Type cmd.exe in the Open field. 

c.   Click OK.
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4.   Type the following command. The following syntax assumes that the existing 

private key in the cimom folder is named icat.ppk. 

copy filename C:\″Program Files″\IBM\svcconsole\cimom\icat.ppk 

where filename is the path and file name of the client SSH private key 

5.   Restart the IBM CIM Object Manager. Select IBM CIM Object Manager in the 

list of services, right click and select Start. 

6.   Log on to the SAN Volume Controller Console. 

7.   Click Clusters in the portfolio. 

8.   Check the status of the cluster.

Setting SAN Volume  Controller user ID and password 

This topic describes how to set the SAN Volume Controller user ID and password 

on the master console. 

These are set using the SAN Volume Controller Web pages accessed using a Web 

browser or using the SAN Volume Controller Console function. See the SAN 

Volume Controller documentation for more information about changing the ID and 

password. 

Changing the master console host name 

You can change the master console host name anytime. When you change the host 

name, you must also be sure that other master console applications are updated to 

use the new name. 

Perform the following steps to change the host name and to update the name in 

other master console applications 

 1.   From the desktop, click Start. 

 2.   Right-click on My Computer. 

 3.   Click Properties. 

 4.   Click Computer Name. 

 5.   Click Change. 

 6.   Type the master console host name in the Computer name field. 

 7.   Click More. 

 8.   Type the full path information in the Primary DNS suffix of this computer 

field. 

 9.   Click OK until you return to the desktop. 

10.   Run the install_path\MasterConsole\Support Utils\mcconfig.exe file, where 

install_path is the drive letter and the directory where the master console is 

installed.
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Chapter  7.  Uninstalling  master  console  software  

This topic provides a high-level overview of the procedures for uninstalling the 

master console software. 

To uninstall the master console software, you must remove the components 

separately using the Microsoft Windows Add or Remove Programs dialog box. 

Because of product dependencies, you must uninstall the software packages in the 

following order: 

1.   IBM Director 

2.   PuTTY 

3.   Adobe Acrobat Reader 

4.   Master console

Note:  When you remove the master console, you remove documentation, 

support utilities, and icons. Therefore, you can continue to access all 

product documentation until you remove the master console. The 

documentation is located in <destination_location>\Documents, where 

<destination_location> is the location where the master console was 

installed on the system. The default location is system_drive\Program 

Files\IBM\MasterConsole.

Accessing the Add or Remove Programs dialog panel 

Perform the following steps to access the Add or Remove Programs dialog panel: 

1.   From the Windows menu bar, click Start → Settings → Control Panel. 

2.   From the Control Panel window, double-click the Add/Remove Programs icon.

Uninstalling IBM Director 

This topic describes how to uninstall IBM Director from the master console using 

the Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall IBM Director: 

1.   In the Add/Remove Programs panel, scroll to IBM Director, and click to select 

it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.
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Uninstalling the SAN Volume  Controller Console 

This topic describes how to uninstall the SAN Volume Controller Console from the 

master console. 

Perform the following steps to uninstall the SAN Volume Controller Console: 

1.   Open the Add/Remove Programs window from the Windows Control Panel. 

2.   Find and select IBM System Storage SAN Volume Controller Console. 

3.   Click Remove or Change. 

4.   Navigate through the uninstallation wizard, selecting the Next button of each 

panel. 

5.   Wait for the program to be removed, and then click Finish 

6.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling PuTTY 

This topic describes how to uninstall PuTTY from the master console using the 

Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall PuTTY: 

1.   In the Add/Remove Programs panel, scroll to PuTTY, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish

Uninstalling Adobe Reader 

You can uninstall Adobe Reader from the system that is running the master 

console. 

Perform the following steps to uninstall Adobe Reader: 

1.   Open the Add or Remove Programs window from the Windows Control Panel. 

2.   Find and select the line for Adobe Reader in the Add or Remove Programs 

window. 

3.   Click Remove or Change. 

4.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

5.   Wait for the program to be removed, and then click Finish.

Uninstalling the master console 

This topic describes how to uninstall the master console. 

This procedure assumes that you have opened the Microsoft Windows Add or 

Remove Programs dialog box. 

Perform the following steps to uninstall the master console: 

 

36 Master Console  Installation and User’s Guide



1.   Find and select IBM System Storage Master Console for SAN Volume 

Controller in the Add or Remove Programs window. 

2.   Click Remove or Change. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product. 

To complete the removal process, you can remove the directory where the master 

console was installed. The default is system_drive\Program Files\IBM\Master 

Console. 
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Chapter  8.  Upgrading  the  master  console  software  

The topics in this section guide you through the upgrade process for the master 

console software. 

Prerequisites for upgrading the master console 

This topic provides an overview of the prerequisites for upgrading the master 

console. 

If you are upgrading the master console software from version 3.2 or an earlier 

version, you might be required to uninstall some components that were previously 

included with the master console. Table 3 provides a list of master console 

components that are not supported by version 4.1 and the prerequisite actions to 

take. 

 Table 3. Unsupported components and actions to take prior to upgrading 

Component Action 

IBM Tivoli Storage Area  Network Manager 

(Tivoli SAN  Manager) Agent 

You must manually uninstall the Tivoli SAN  

Manager Agent. The “Uninstalling Tivoli 

SAN  Manager Agent” topic provides 

instructions for uninstalling this component. 

IBM Tivoli SAN  Manager You must manually uninstall the Tivoli SAN  

Manager. The “Uninstalling Tivoli SAN  

Manager” on page 40 topic provides 

instructions for uninstalling this component. 

DS4000 Storage Manager Client (FAStT 

Storage Manager Client) 

Unless you currently use the DS4000 Storage 

Manager Client, you must uninstall it. 

“Uninstalling the DS4000 Storage Manager 

Client (FAStT Storage Manager Client)” on 

page 40 provides instructions for 

uninstalling this component. 

IBM Connection Manager The IBM Connection Manager is 

automatically uninstalled during the master 

console upgrade process. You do not need to 

take any action.
  

Uninstalling Tivoli  SAN Manager Agent 

This topic describes how to uninstall Tivoli SAN Manager Agent from the master 

console using the Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall the Tivoli SAN Manager Agent: 

1.   In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area 

Network Manager - Agent, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 
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4.   Wait for the program to be removed, and then click Finish. 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling Tivoli  SAN Manager 

This topic describes how to uninstall Tivoli SAN Manager from the master console 

using the Add/Remove Programs dialog panel. 

This procedure assumes that you have performed the following actions: 

v   Uninstalled the Tivoli SAN Manager Agent 

v   Accessed the Add/Remove Programs dialog panel

Perform the following steps to uninstall the Tivoli SAN Manager: 

1.   In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area 

Network Manager - Manager, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish. 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product. 

6.   Remove the directory where the Tivoli SAN Manager and the Tivoli SAN 

Manager Agent were installed. By default, this directory is C:\Tivoli.

Uninstalling the DS4000 Storage Manager Client (FAStT 

Storage Manager Client) 

This topic describes how to uninstall the DS4000 Storage Manager Client (FAStT 

Storage Manager Client) from the master console using the Add/Remove Programs 

dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall the DS4000 Storage Manager Client (FAStT 

Storage Manager Client): 

1.   In the Add/Remove Programs panel, scroll to the product name, and click to 

select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish. 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Upgrading the master console to version 4.1 

This topic provides information about upgrading the master console to version 4.1. 

Before you begin the upgrade process, ensure that you have performed the 

following actions: 

v   Logged in using a user ID with administrative privileges 
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v   Uninstalled any components that are not supported by the new version. For 

more information, see “Prerequisites for upgrading the master console” on page 

39.

Perform the following steps to upgrade the master console software: 

 1.   Insert the Master Console CD 1 in the CD drive. 

 2.   Click Start → Run to open the Run dialog box. 

 3.   Enter cd_drive:\setup.exe, where cd_drive is the letter of the drive in which you 

inserted the CD, and click OK. 

The following message is displayed in a window: 

+---------------------------------------------------------------+ 

| InstallShield(R) is preparing the InstallShield Wizard, which | 

| will guide you through the rest of the process.               | 

| Please wait .........                                         | 

|                                                               | 

| Preparing Java (tm) Virtual Machine                           | 

+--------------------------------------------------------------+ 

 4.   When you are prompted, select the language to be used for the installation 

wizard and click OK. 

 5.   The installation wizard Welcome panel is displayed. Click Next. 

 6.   The installation wizard License Agreement panel is displayed. Click I accept 

the terms in the license agreement, and then click Next to continue the 

upgrading. 

The installation wizard verifies that all software prerequisites are installed on 

the system. If they are not, a window opens describing the prerequisites that 

are not currently installed. Click OK to stop the installation wizard, then 

install the prerequisite software. After you have installed the prerequisites, 

start the installation wizard again. 

The installation wizard displays the version of the currently installed master 

console. 

 7.   Click Next to continue upgrading. 

If any hardware requirements are not met on your system, a panel is 

displayed that indicates the hardware requirements that are not met and 

warning about a decrease of the performance level if these requirements are 

not met. 

 8.   If the existing Adobe Reader is an earlier version than the required version, or 

if Adobe Reader is not installed on your system, the installation wizard panel 

Upgrading/Installing the Adobe Reader is displayed. Click Next to begin the 

upgrading or installation of Adobe Reader. 

When the installation is complete, the Useful Information panel is displayed. 

From this panel, you can access this document or IBM Support Web sites by 

following the instructions on the panel. 

 9.   Click Next after you read the Useful Information panel. 

The Destination panel is displayed. 

10.   Specify the destination directory for the master console software. You can keep 

the old destination location displayed on the panel or select a different 

location. If you select a different location, the installation program first 

uninstalls the product from the old location and then installs the master 

console software in the new location that you specified. 

11.   Wait for the installation program to stop the master console information center 

service. 

The installation wizard displays the Select the information center port panel. 
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12.   Keep the existing information center port value or change it. To change the 

information center port value, specify an unused port value between 1 and 

65535. To see the ports that are being used by other applications, open a 

Command Prompt window, and enter the netstat -a command. 

The Select the optional features panel is displayed. 

13.   Specify whether you want the IBM System Storage SAN Volume Controller 

Console to be installed or upgraded, and then click Next. 

Note:  If you clear the SAN Volume Controller Console option, a warning 

message is displayed before the List of products panel is displayed. 

This message warns that you should clear the SAN Volume Controller 

Console check box only when the SAN Volume Controller Console is 

not part of the current configuration. 

The List of products panel is displayed. 

14.   Review the information on the List of products panel. The list of products 

compares the installed product versions with the required ones in a table with 

the following columns: 

v   Products of the master console 

v   Versions of the already installed products 

v   Required versions for the products 

v   Actions to be done by the master console installation wizard 

The table containing the list of the products to be installed or upgraded is 

saved as MasterConsoleProducts.htm in the location where the master console is 

installed. 

Depending on the installed version of each product, the installation wizard 

determines whether to install or upgrade the product using the following 

conditions: 

v   If the product is installed and its installed version is an earlier version than 

the required version, the installation wizard upgrades the product by 

launching the product-specific installer. 

v   If the product is installed at a version equal to or later than the required 

version, the installation wizard does not install that product. The 

corresponding panels that launch and verify the specific product installation 

are skipped. When the existing version is a later versions than the required 

version, the installation wizard displays a warning telling you that your 

existing version has not been tested with the master console. 

v   If a product from the list of products to be installed or upgraded is found 

to be not properly installed on the system, you are asked to continue with 

the installation by trying to reinstall the product with the product-specific 

installer. If this action does not succeed, exit the master console installation 

wizard, manually remove the product from your system, and restart the 

master console installation wizard.
15.   From the List of products panel, click Next to continue upgrading the 

products. 

The installation wizard launches the necessary product-specific installation 

programs. During the installation, change CDs if prompted. For details about 

individual product installations, you can see the Chapter 4, “Installing master 

console software,” on page 11 topic and its subtopics.

Note:  Upgrades to the master console software products are also available at 

the following Web site: http://www.ibm.com/storage/support/2145. 

Instructions for downloading and installing upgraded software 

packages are available at this site too.
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If you receive a message telling you to change the property value for the user 

name, manually change the Log On As property of the IBM Director Server 

service by performing the following steps: 

a.   Open the Services window by selecting Start → Settings → Control Panel → 

Administrative Tools → Services. 

b.   In the Services window, select the IBM Director Server service. 

c.   Right-click on the selected service, and select Properties to open IBM 

Director Server Properties. 

d.   Click on the Log On tab and deselect the Local System account radio 

button. 

e.   Select This account radio button and then enter the user ID and its 

password. 

f.   Save the changes by clicking the Apply button. 

g.   Click OK. 

You must remember the IBM Director account and password because you are 

asked for it when you upgrade the IBM Director and preconfigure it (see step 

16). This account value is read by the installer as the default value for the IBM 

Director account during the upgrade. 

After the product-specific installations are complete, the installation wizard 

displays the IBM Director Superuser Account panel. 

16.    In the IBM Director Superuser Account panel, enter the IBM Director 

superuser name and password. The installation program starts the IBM 

Director Support Program service so that the installation can perform the 

preconfiguration tasks. 

17.   Wait for IBM Director to start and then discover the Director-managed 

systems. 

If IBM Director was never preconfigured since its installation (that is, there are 

no action plans for managing specific events defined in the Director), the 

installation program performs the IBM Director preconfiguration tasks. These 

tasks consist of creating a set of action plans designated for managing specific 

events that are generated by the master console system. These action plans are 

imported from configuration archive files that exist on the installation 

package. If one or more configuration files are not found on the installation 

package, or if an error occurs while action plans are being imported, a 

message is displayed warning that these action plans must be manually 

created after installation is completed. 

18.   Upgrade the master console documentation and support utilities by 

performing the following steps: 

a.   Restart the system if prompted after the installation wizard uninstalls the 

old documentation and utility files, Document Launcher, and information 

center. 

b.   From the Documents and Support Utilities installation panel, click Next to 

begin the installation of new documentation and utilities files. 

c.   If prompted to insert a different CD, insert it in the CD drive and enter the 

CD drive letter in the location field. Then click OK. 

The installation wizard copies the Eclipse files of the IBM WebSphere Help 

System and installs the master console information center (copying master 

console-specific documentations into the IBM WebSphere Help System). 

The program installs the master console information center as a service. 

After all documentation and utilities are installed, the Finish panel is 

displayed.
19.   Click Finish. 
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20.   If a system reboot is required, accept the prompt to complete the master 

console upgrading process. 

21.   Review the master console installation log (mclog.txt) to ensure that all 

products are properly installed. The log file is located in 

<installation_directory>\logs, where <installation_directory> is the directory 

where the master console was installed. The default installation directory is 

C:\Program Files\IBM\MasterConsole.
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Chapter  9.  Troubleshooting  the  master  console  

These topics provide information that you need to troubleshoot and resolve 

problems with the master console. 

In addition to troubleshooting by yourself, you can also request a Virtually On-site 

session with an IBM service representative. 

   Related concepts 

   “Virtually On-site and remote service” on page 4
When you contact IBM to help you resolve a problem with your SAN Volume 

Controller system, the IBM service representative might suggest using IBM 

Virtually On-site (VOS) tool to remotely access the master console. This type of 

remote service can help you reduce service costs and shorten repair times.

Recovering from a disk failure on the master console system 

At some point, you might have to recover from a disk failure on the system that 

runs the master console. 

When you set up mirroring, the hard disk drive on the system that runs the master 

console is actually a mirrored pair of hard disks. This strategy protects against loss 

of the master console due to a disk failure. If one of these mirrored pair of disk 

drives fails and must be replaced, perform the following steps: 

 1.   Right-click the My Computer icon on your desktop and select Manage. 

 2.   Select Disk Management. The hard drives are displayed in the right panel. 

 3.   If the failing disk drive is displayed, right-click the main volume of the drive 

and select Break Mirror. 

 4.   Shut down the computer that runs the master console and replace the failing 

disk drive using the procedures that are detailed in the documentation for 

your replacement hard drive. Ensure that the new drive has its jumpers set 

the same as the drive that is being replaced. The new drive must be the same 

capacity or larger than the drive being replaced. 

Notes:  

a.   It can be difficult to tell which of the two drives has failed. In this 

case, reboot with each drive one at a time to isolate the failed 

drive. 

b.   If the replacement drive has a boot record that is present, erase the 

boot record prior to using the replacement drive. However, if the 

master console computer fails to boot because it cannot find the 

boot record, change the boot sequence in the BIOS to the other 

hard drive.
 5.   Restart the computer. 

 6.   Right-click the My Computer icon on your desktop and select Manage. 

 7.   Select Disk Management. The hard drives display in the right panel. 

 8.   If a disk drive is marked Missing, remove that disk drive by right-clicking the 

drive and selecting Remove Disk. 

 9.   If the new disk drive has a no entry sign that is displayed on it, right-click 

that disk drive and select Write Signature. This removes the no entry sign. 

10.   Right-click the new disk drive and select Upgrade to Dynamic Disk. 
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11.   Right-click the volume that you want to mirror and select Add Mirror. The 

Add Mirror wizard is started. 

12.   Use the Add Mirror wizard to configure the second volume. 

13.   Ignore the window for making changes to the boot.ini file. 

The status of both volumes, the existing drive, and the new drive changes to 

Regenerating. After a short period of time, the status shows the percentage of 

regeneration that has completed. When the regeneration completes, the status 

displays as Healthy.

Troubleshooting  SAN Volume  Controller Console problems 

If you have problems with the SAN Volume Controller Console, you can use the 

instructions in this topic to help you resolve them. 

If the SAN Volume Controller Console closes unexpectedly 

 This problem has the following symptoms: 

v   The following dialog box is displayed: 

You have signed off 

v   The window closes.

To resolve this problem, perform the following actions: 

1.   Before checking for hardware errors, open a new browser window and 

attempt to reconnect to the SAN Volume Controller Console. The logoff 

message is generally caused by the open session timing out (the 

browser window was left open from a previous session). 

2.   If you cannot reconnect, try the following actions to resolve the 

problem: 

v   Check the current memory availability. This problem can be caused 

by a memory failure in the master console, causing it to run with less 

than the required memory. If there is a memory problem, you must 

correct it. 

v   Determine if the IP address of the master console has changed since 

the last reboot. If so, reboot the master console to correct the 

problem.

Troubleshooting  Windows boot problems 

If you have problems with the Microsoft Windows booting, you can use the 

instructions in this topic to help you resolve them. 

If Windows does not boot 

 During the Windows boot process, if Windows tries to start but fails with a 

‘blue screen’ with a Inaccessible Boot Device message and another reboot 

does not solve the problem, this could be due to the windows boot code 

being corrupted on the startup device. 

 Perform the following steps to resolve the problem: 

1.   Reboot the computer where the master console resides. 

2.   Press F1 to display the Configuration/Setup menu. 

3.   Select Start Options. 

4.   Select Start Sequence. 

5.   Step down the sequence to the one that contains the hard disk. 
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6.   Use the left and right cursor keys to select the other hard disk. For 

example, if the hard disk is set to 1, select 0. If it is set to 0, select 1. 

7.   Press Esc to exit until you get the option to save and exit. Then select 

Yes.  

8.   If the master console boots, proceed with the steps for recovering from 

a master console disk failure. Otherwise, contact your IBM service 

representative.

Viewing  error information on the master console 

This topic describes how to view error information on the master console. 

All of the SAN Volume Controller nodes, fibre-channel switches, and storage 

generate SNMP traps as a result of events, such as errors and configuration 

changes. The errors are usually sent to the IBM Director and are listed in the 

Director Event Log. You can view all the events with their time stamps to help you 

determine which event is most likely to have caused the problem. 

For example, the loss of a fibre-channel path or link because of a cable or GBIC 

fault can result in a number of different events being logged to the Director Event 

Log from the devices at each end of the failing cable, such as a SAN Volume 

Controller, fibre-channel switch, or storage. 

If you identify a fibre-channel path or link problem, the failure might be the 

fibre-channel cable, GBICs, SAN component, or host adapter at the ends of the 

failing link. 

To resolve the problem, you might have to see the service documentation for the 

link end device involved (for example, the SAN Volume Controller, fibre-channel 

switch, or host) 

If you identify a particular SAN component failure, see the service documentation 

for that component to resolve the problem. The master console C:\Documents 

directory contains documentation for some components. 
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Appendix.  Accessibility  features  for  the  SAN  Volume  

Controller  

Accessibility features help users who have a physical disability, such as restricted 

mobility or limited vision, to use information technology products successfully. 

Accessibility features for the SAN Volume Controller 

The following list includes the major accessibility features in the SAN Volume 

Controller. These features support: 

v   Keyboard-only operation. 

v   Interfaces that are commonly used by screen readers. 

v   Keys that are tactilely discernible and do not activate just by touching them 

v   Industry-standard devices for ports and connectors. 

v   The attachment of alternative input and output devices.

Tip:   The SAN Volume Controller Information Center and its related publications 

are accessibility-enabled for the IBM Home Page Reader. You can operate all 

features using the keyboard instead of the mouse. 

Keyboard navigation 

This product uses standard Microsoft Windows navigation keys. 

IBM and accessibility 

See the IBM Accessibility Center for more information about the commitment that 

IBM has to accessibility. 
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Notices  

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may 

be used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you 

any license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATIONS ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply 

to you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements 

and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those Web 

sites. The materials at those Web sites are not part of the materials for this IBM 

product and use of those Web sites is at your own risk. 
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IBM may use or distribute any of the information you supply in any way it 

believes appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose 

of enabling: (i) the exchange of information between independently created 

programs and other programs (including this one) and (ii) the mutual use of the 

information which has been exchanged, should contact:

IBM Corporation 

Almaden Research 

650 Harry Road 

Bldg 80, D3-304, Department 277 

San Jose, CA  95120-6099 

U.S.A. 

Any performance data contained herein was determined in a controlled 

environment. Therefore, the results obtained in other operating environments may 

vary significantly. Some measurements may have been made on development-level 

systems and there is no guarantee that these measurements will be the same on 

generally available systems. Furthermore, some measurement may have been 

estimated through extrapolation. Actual results may vary. Users of this document 

may verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 

those products, their published announcements or other publicly available sources. 

IBM has not tested those products and cannot confirm the accuracy of 

performance, compatibility or any other claims related to non-IBM products. 

Questions on the capabilities of non-IBM products may be addressed to the 

suppliers of those products. 

All statements regarding IBM’s future direction or intent are subject to change or 

withdrawal without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to 

change before the products described become available. 

This information contains examples of data and reports used in daily business 

operations. To illustrate them as completely as possible, the examples include the 

names of individuals, companies, brands, and products. All of these names are 

fictitious and any similarity to the names and addresses used by an actual business 

enterprise is entirely coincidental. 

Trademarks 

The following terms are trademarks of the International Business Machines 

Corporation in the United States, other countries, or both: 

v   DB2 

v   eServer 

v   IBM 

v   NetView 

v   System Storage 

v   Tivoli 

v   TotalStorage 
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v   WebSphere 

v   xSeries

Intel and Pentium are trademarks of Intel Corporation in the United States, other 

countries, or both. 

Java™ and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in 

the United States, other countries, or both. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United 

States, other countries, or both. 

Linux® is a trademark of Linus Torvalds in the United States, other countries, or 

both. 

Other company, product, and service names may be trademarks or service marks 

of others. 

Electronic emission notices 

The following electronic emission statements apply to this product. The statements 

for other products that are intended for use with this product are included in their 

accompanying documentation. 

Federal Communications Commission (FCC) Class A 

Statement 

Note: This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, 

uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause 

harmful interference, in which case the user will be required to correct the 

interference at his own expense. 

Properly shielded and grounded cables and connectors must be used in order to 

meet FCC emission limits. IBM is not responsible for any radio or television 

interference caused by using other than recommended cables and connectors or by 

unauthorized changes or modifications to this equipment. Unauthorized changes 

or modifications could void the user’s authority to operate the equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that 

may cause undesired operation. 

Industry Canada Class A Emission Compliance Statement 

This Class A digital apparatus complies with Canadian ICES-003. 

Avis de conformité à la réglementation d’Industrie Canada 

Cet appareil numérique de la classe A est conform à la norme NMB-003 du 

Canada. 
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Japan VCCI Class A ITE Electronic Emission Statement 

   

European Union (EU) Electromagnetic Compatibility Directive 

This product is in conformity with the protection requirements of EU Council 

Directive 89/336/EEC on the approximation of the laws of the Member States 

relating to electromagnetic compatibility. IBM cannot accept responsibility for any 

failure to satisfy the protection requirements resulting from a non-recommended 

modification of the product, including the fitting of non-IBM option cards. 

This product has been tested and found to comply with the limits for Class A 

Information Technology Equipment according to European Standard EN 55022. The 

limits for Class A equipment were derived for commercial and industrial 

environments to provide reasonable protection against interference with licensed 

communication equipment. 

 Attention:  This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

Properly shielded and grounded cables and connectors must be used in order to 

reduce the potential for causing interference to radio and TV communications and 

to other electrical or electronic equipment. Such cables and connectors are available 

from IBM authorized dealers. IBM cannot accept responsibility for any interference 

caused by using other than recommended cables and connectors. 

Germany Electromagnetic Compatibility Directive 

Zulassungsbescheinigung laut dem Deutschen Gesetz über die 

elektromagnetische Verträglichkeit von Geräten (EMVG) vom 18. September 

1998 (bzw. der EMC  EG Richtlinie 89/336) 

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das 

EG-Konformitätszeichen - CE - zu führen. 

Verantwortlich für die Konformitätserklärung nach Paragraph 5 des EMVG ist die: 

IBM Deutschland Informationssysteme GmbH 70548 Stuttgart. 

Informationen in Hinsicht EMVG Paragraph 4 Abs. (1) 4: 

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und 

EN 55022 Klasse A. 

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden: 

″Warnung: dies ist eine Einrichtung der Klasse A. Diese Einrichtung kann im 

Wohnbereich Funkstörungen verursachen; in diesem Fall kann vom Betreiber 

verlangt werden, angemessene Maßnahmen durchzuführen und dafür 

aufzukommen.″ 

Anmerkung: Um die Einhaltung des EMVG sicherzustellen, sind die Geräte wie in 

den IBM Handbüchern angegeben zu installieren und zu betreiben. 
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People’s Republic of China Class A Electronic Emission 

Statement 

   

Taiwan  Class A Electronic Emission Statement 

   

Korea Class A Electronic Emission Statement 
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Glossary  

Glossary 

This glossary includes terms for the IBM System 

Storage master console for SAN Volume 

Controller. 

This glossary includes selected terms and 

definitions from A Dictionary of Storage 

Networking Terminology (http://www.snia.org/
education/dictionary), copyrighted 2001 by the 

Storage Networking Industry Association, 2570 

West El Camino Real, Suite 304, Mountain View, 

California 94040-1313. Definitions derived from 

this book have the symbol (S) after the definition. 

The following cross-references are used in this 

glossary: 

See Refers the reader to one of two kinds of 

related information: 

v   A term that is the expanded form of an 

abbreviation or acronym. This 

expanded form of the term contains the 

full definition. 

v   A synonym or more preferred term.

See also 

Refers the reader to one or more related 

terms. 

Contrast with 

Refers the reader to a term that has an 

opposite or substantively different 

meaning.

A 

access 

v   To obtain computing services or data. 

v   The ability to read, update, or 

otherwise use a resource. Access to 

protected resources is usually 

controlled by system software.

alert 

v   A message or other indication that 

identifies a problem or an impending 

problem. 

v   A message or log that a storage facility 

generates as the result of the collection 

and analysis of error events. An alert 

indicates that a service action is 

required. 

v   A message sent to a management 

services focal point in a network to 

identify a problem or an impending 

problem.

application server 

A host that is attached to the storage area 

network (SAN) and that runs 

applications. 

authentication 

v   In computer security, verification of the 

identity of a user or process and the 

construction of a data structure that 

contains the privileges that were 

granted to the user or process. 

v   In computer security, a process that 

ensures that the identities of both the 

sender and the receiver of a network 

transaction are true.

availability 

The ability of a system to continue 

working, with perhaps a decrease in 

performance, after individual components 

fail.

B 

boot drive 

A disk drive that contains the operating 

system. When PCs came with a diskette 

drive, they were set to look for a bootable 

disk during startup in the diskette drive 

first, CD-ROM drive second and hard 

disk drive third. Today, many PCs come 

without a diskette drive, and the order is 

typically CD-ROM first and hard disk 

drive second, although this order can be 

changed in the BIOS setup.

C 

call home 

A communication service that links a 

machine to a service provider. The 

machine can use this link to place a call 

to IBM or to another service provider 

when service is required. With access to 

the machine, service personnel can 

 

© Copyright  IBM Corp.  2004, 2006 57



perform service tasks, such as viewing 

error and problem logs or initiating trace 

and dump retrievals. 

CIM See Common Information Model. 

CIM object manager (CIMOM) 

The common conceptual framework for 

data management that receives, validates, 

and authenticates the CIM requests from 

the client application. It then directs the 

requests to the appropriate component or 

service provider. 

CIMOM 

See CIM object manager. 

CLI See command line interface. 

client A computer system or process that 

requests a service of another computer 

system or process that is typically referred 

to as a server. Multiple clients can share 

access to a common server. 

cluster 

In SAN Volume Controller, a pair of 

nodes that provides a single configuration 

and service interface. 

command line-interface (CLI) 

A type of computer interface in which the 

input command is a string of text 

characters. 

Common Information Model (CIM) 

A set of standards developed by the 

Distributed Management Task Force 

(DMTF). CIM provides a conceptual 

framework for storage management and 

an open approach to the design and 

implementation of storage systems, 

applications, databases, networks, and 

devices. 

console 

v   A device for graphical or textual visual 

output from a computer system. (S) 

v   In systems, network and device 

management, an application that 

provides graphical and textual feedback 

regarding operation and status, and 

that may accept operator commands 

and input influencing operation and 

status. (S) 

v   See also master console.

D 

data migration 

The movement of data from one physical 

location to another without disrupting 

I/O operations. 

degraded 

Pertaining to a valid configuration that 

has suffered a failure but continues to be 

supported and legal. Typically, a repair 

action can be performed on a degraded 

configuration to restore it to a valid 

configuration. 

device 

v   In the CIM Agent, the storage server 

that processes and hosts client 

application requests. 

v   IBM definition: A piece of equipment 

that is used with the computer and 

does not generally interact directly with 

the system, but is controlled by a 

controller. 

v   HP definition: In its physical form, a 

magnetic disk that can be attached to a 

SCSI bus. The term is also used to 

indicate a physical device that has been 

made part of a controller configuration; 

that is, a physical device that is known 

to the controller. Units (virtual disks) 

can be created from devices after the 

devices have been made known to the 

controller.

disk drive 

A disk-based, nonvolatile, storage 

medium. 

domain name server 

In the Internet suite of protocols, a server 

program that supplies name-to-address 

conversion by mapping domain names to 

IP addresses.

E 

error code 

A value that identifies an error condition. 

Ethernet 

A packet-based networking technology for 

local area networks (LANs) that allows 

multiple access and handles contention by 

using Carrier Sense Multiple Access with 

Collision Detection (CSMA/CD) as the 

access method. Ethernet is standardized 

in the IEEE 802.3 specification.

 

58 Master Console  Installation and User’s Guide



F 

fabric In fibre-channel technology, a routing 

structure, such as a switch, that receives 

addressed information and routes it to the 

appropriate destination. A fabric can 

consist of more than one switch. When 

multiple fibre-channel switches are 

interconnected, they are described as 

cascading. See also cascading. 

fibre channel 

A technology for transmitting data 

between computer devices at a data rate 

of up to 4 Gbps. It is especially suited for 

attaching computer servers to shared 

storage devices and for interconnecting 

storage controllers and drives. 

file metadata 

Information about the file, such as owner, 

permission, and physical location. This 

information is stored in the system 

storage pool. 

firewall 

A network configuration, usually both 

hardware and software, that prevents 

unauthorized traffic into and out of a 

secure network.

G 

gateway 

An entity that operates above the link 

layer and translates, when required, the 

interface and protocol used by one 

network into those used by another 

distinct network. 

GB See gigabyte. 

GBIC See gigabit interface converter. 

gigabit interface converter (GBIC) 

An interface module that converts the 

light stream from a fibre-channel cable 

into electronic signals for use by the 

network interface card. 

gigabyte (GB) 

In decimal notation, 1 073 741 824 bytes.

H 

hardcoded 

Pertaining to software instructions that 

are statically encoded and not intended to 

be altered. 

host name 

v   The network name for a network 

adaptor on a physical machine in 

which the node is installed. 

v   In Internet communications, the name 

given to a computer. Sometimes, host 

name is used to mean the fully 

qualified domain name; other times, it 

is used to mean the most specific 

subname of a fully qualified domain 

name. For example, if 

mycomputer.city.company.com is the 

fully qualified domain name, either of 

the following may be considered the 

host name: 

mycomputer.city.company.com, 

mycomputer.

I 

ID See identifier. 

identifier (ID) 

A sequence of bits or characters that 

identifies a user, program device, or 

system to another user, program device, 

or system. 

illegal configuration 

A configuration that will not operate and 

will generate an error code to indicate the 

cause of the problem. 

input/output (I/O) 

Pertaining to a functional unit or 

communication path involved in an input 

process, an output process, or both, 

concurrently or not, and to the data 

involved in such a process. 

instance 

An individual object that is a member of 

some class. In object-oriented 

programming, an object is created by 

instantiating a class. 

integrity 

The ability of a system to either return 

only correct data or respond that it cannot 

return correct data. 

Internet Protocol (IP) 

In the Internet suite of protocols, a 

connectionless protocol that routes data 

through a network or interconnected 

networks and acts as an intermediary 

between the higher protocol layers and 

the physical network. 

interoperability 

The capability to communicate, run 
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programs, or transfer data among various 

functional units in a way that requires the 

user to have little or no knowledge of the 

unique characteristics of those units. 

I/O See input/output. 

IP See Internet Protocol. 

IP address 

The unique 32-bit address that specifies 

the location of each device or workstation 

in the Internet. For example, 9.67.97.103 is 

an IP address.

J 

JBOD (just a bunch of disks) 

v   IBM definition: See non-RAID. 

v   HP definition: A group of single-device 

logical units not configured into any 

other container type.

K 

key In computer security, a sequence of 

symbols that is used with a cryptographic 

algorithm for encrypting or decrypting 

data. See also private key, public key.

L 

local fabric 

In SAN Volume Controller, those storage 

area network (SAN) components (such as 

switches and cables) that connect the 

components (nodes, hosts, switches) of 

the local cluster together.

M 

Management Information Base (MIB)  

Simple Network Management Protocol 

(SNMP) units of managed information 

that specifically describe an aspect of a 

system, such as the system name, 

hardware number, or communications 

configuration. A collection of related MIB  

objects is defined as a MIB. 

master console 

A single point from which to manage the 

IBM System Storage™ SAN Volume 

Controller. The master console product 

can be purchased as software that is 

installed and configured on a server or as 

a hardware platform with the operating 

system and master console software 

preinstalled. 

MB See megabyte. 

megabyte (MB) 

In decimal notation, 1 048 576 bytes. 

MIB  See Management Information Base. 

migration 

See data migration. 

mirroring 

v   The process of writing the same data to 

two disk units within the same 

auxiliary storage pool at the same time. 

The two disk units become a mirrored 

pair, allowing the system to continue 

when one of the mirrored units fails. 

v   The process of writing the same data to 

multiple disks at the same time. The 

mirroring of data protects it against 

data loss within the database or within 

the recovery log. 

v   A form of storage array in which two 

or more identical copies of data are 

maintained on separate media. Also 

known as RAID Level 1, disk 

shadowing, real-time copy, and t1 copy. 

(S)

N 

node 

v   One SAN Volume Controller. Each 

node provides virtualization, cache, and 

Copy Services to the storage area 

network (SAN). 

v   An addressable entity connected to an 

I/O bus or network. Used primarily to 

refer to computers, storage devices, and 

storage subsystems. The component of 

a node that connects to the bus or 

network is a port. (S)

node name 

A name identifier associated with a node. 

(S)

O 

object In object-oriented design or programming, 

a concrete realization of a class that 

consists of data and the operations 

associated with that data. 

offline 

Pertaining to the operation of a functional 

unit or device that is not under the 

continual control of the system or of a 

host. 
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offshift 

A person’s non-working hours. 

online Pertaining to the operation of a functional 

unit or device that is under the continual 

control of the system or of a host.

P 

paused 

In SAN Volume Controller, the process by 

which the cache component quiesces all 

ongoing I/O activity below the cache 

layer. 

pend To cause to wait for an event. 

petabyte (PB) 

In decimal notation, 1 125 899 906 842 624 

bytes. 

port The physical entity within a host, SAN 

Volume Controller, or disk controller 

system that performs the data 

communication (transmitting and 

receiving) over the fibre channel. 

power-on self-test 

A diagnostic test that servers or 

computers run when they are turned on. 

Sometimes called POST. 

private key 

v   In computer security, a key that is 

known only to its owner. See also public 

key. 

v   In secure communication, an 

algorithmic pattern used to encrypt 

messages that only the corresponding 

public key can decrypt. The private key 

is also used to decrypt messages that 

were encrypted by the corresponding 

public key. The private key is kept on 

the user’s system and is protected by a 

password. See also key, public key.

property 

In the Common Information Model 

(CIM), an attribute that is used to 

characterize instances of a class. 

public key 

v   In computer security, a key that is 

made available to everyone. See also 

private key. 

v   In secure communication, an 

algorithmic pattern used to decrypt 

messages that were encrypted by the 

corresponding private key. A public key 

is also used to encrypt messages that 

can be decrypted only by the 

corresponding private key. Users 

broadcast their public keys to everyone 

with whom they must exchange 

encrypted messages. See also key, 

private key.

PuTTY 

A client program that allows you to run 

remote sessions on your computer 

through specific network protocols, such 

as SSH, Telnet, and Rlogin.

Q 

qualifier 

A value that provides additional 

information about a class, association, 

indication, method, method parameter, 

instance, property, or reference.

R 

rack A free-standing framework that holds the 

devices and card enclosure. 

reference 

A pointer to another instance that defines 

the role and scope of an object in an 

association. 

reliability 

The ability of a system to continue to 

return data even if a component fails. 

remote fabric 

In Global Mirror, the storage area network 

(SAN) components (switches and cables) 

that connect the components (nodes, 

hosts, and switches) of the remote cluster. 

roles Authorization is based on roles that map 

to the administrator and service roles in 

an installation. The switch translates these 

roles into SAN Volume Controller 

administrator and service user IDs when 

a connection is made to the node for the 

SAN Volume Controller.

S 

SAN See storage area network. 

SCSI See Small Computer Systems Interface. 

SCSI back-end layer 

The layer in a Small Computer Systems 

Interface (SCSI) network that performs the 

following functions: controls access to 

individual disk controller systems that are 
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managed by the cluster; receives requests 

from the virtualization layer, processes 

them, and sends them to managed disks; 

addresses SCSI-3 commands to the disk 

controller systems on the storage area 

network (SAN). 

SCSI front-end layer 

The layer in a Small Computer Systems 

Interface (SCSI) network that receives I/O 

commands sent from hosts and provides 

the SCSI-3 interface to hosts. SCSI logical 

unit numbers (LUNs) are mapped to 

virtual disks (VDisks) in this layer as 

well. Thus, the layer converts SCSI read 

and write commands that are addressed 

to LUNs into commands that are 

addressed to specific VDisks. 

SDD See subsystem device driver. 

Secure Shell 

A program to log in to another computer 

over a network, to execute commands in 

a remote machine, and to move files from 

one machine to another. 

server In a network, the hardware or software 

that provides facilities to other stations; 

for example, a file server, a printer server, 

a mail server. The station making the 

request of the server is usually called the 

client. 

Service Location Protocol (SLP) 

In the Internet suite of protocols, a 

protocol that identifies and uses network 

hosts without having to designate a 

specific network host name. 

Simple Mail Transfer Protocol (SMTP) 

An Internet application protocol for 

transferring mail among users of the 

Internet. SMTP specifies the mail 

exchange sequences and message format. 

It assumes that the Transmission Control 

Protocol (TCP) is the underlying protocol. 

Simple Network Management Protocol (SNMP) 

In the Internet suite of protocols, a 

network management protocol that is 

used to monitor routers and attached 

networks. SNMP is an application-layer 

protocol. Information on devices managed 

is defined and stored in the application’s 

Management Information Base (MIB). 

SLP See Service Location Protocol. 

Small Computer System Interface (SCSI) 

A standard hardware interface that 

enables a variety of peripheral devices to 

communicate with one another. 

SMI-S See Storage Management Initiative 

Specification. 

SMTP See Simple Mail Transfer Protocol. 

SNIA See Storage Networking Industry Association. 

SNMP 

See Simple Network Management Protocol. 

SSH See Secure Shell. 

storage area network (SAN) 

A network whose primary purpose is the 

transfer of data between computer 

systems and storage elements and among 

storage elements. A SAN consists of a 

communication infrastructure, which 

provides physical connections, and a 

management layer, which organizes the 

connections, storage elements, and 

computer systems so that data transfer is 

secure and robust. (S) 

Storage Management Initiative Specification 

(SMI-S) 

A design specification developed by the 

Storage Networking Industry Association 

(SNIA) that specifies a secure and reliable 

interface that allows storage management 

systems to identify, classify, monitor, and 

control physical and logical resources in a 

storage area network. The interface is 

intended as a solution that integrates the 

various devices to be managed in a 

storage area network (SAN) and the tools 

used to manage them. 

Storage Networking Industry Association 

(SNIA) 

An association of producers and 

consumers of storage networking 

products whose goal is to further storage 

networking technology and applications. 

See www.snia.org. 

subsystem device driver (SDD) 

An IBM pseudo device driver designed to 

support the multipath configuration 

environments in IBM products. 

subnet 

v   A network divided into smaller 

interconnected, but independent 

subgroups. 
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v   To divide a network into smaller 

interconnected, but independent 

subgroups.

superuser authority 

The level of access required to add users. 

switch A network infrastructure component to 

which multiple nodes attach. Unlike hubs, 

switches typically have internal 

bandwidth that is a multiple of link 

bandwidth, and the ability to rapidly 

switch node connections from one to 

another. A typical switch can 

accommodate several simultaneous full 

link bandwidth transmissions between 

different pairs of nodes. (S) Contrast with 

hub. 

system 

A functional unit, consisting of one or 

more computers and associated software, 

that uses common storage for all or part 

of a program and also for all or part of 

the data necessary for the execution of the 

program. A computer system can be a 

stand-alone unit, or it can consist of 

multiple connected units.

T 

terabyte 

In decimal notation, 1 099 511 628 000 

bytes.

V 

valid configuration 

A configuration that is supported. 

virtualization 

In the storage industry, a concept in 

which a pool of storage is created that 

contains several disk subsystems. The 

subsystems can be from various vendors. 

The pool can be split into virtual disks 

that are visible to the host systems that 

use them. 

virtual private network (VPN) 

An extension of a company’s intranet 

over the existing framework of either a 

public or private network. 

Virtually On-site (VOS) 

A worldwide IBM Technical Support 

remote desktop sharing solution, used to 

allow an IBM service representative to 

remotely access your system and help you 

resolve hardware, software, or operational 

problems. 

VOS See Virtually On-site. 

VPN See virtual private network.
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